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While I have made every effort to ensure the accuracy of this document, including grammar 
and instructions, I make mistakes. (Surprise!)  If you find an error or want to provide 
constructive feedback, please contact me.  Thank you!  Enjoy PowerPoint and this document. 
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PowerPoint ® is a most excellent product from Microsoft ® Corporation and is part of the 
Office ® Suite of products and services.  

Copyright © 2015 Greg Creech, Techedutainment Services, Inc..  All rights reserved.  This 
publication, or any part thereof, may not be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopying, recording, storage in an information 
retrieval system, or otherwise, without express written permission of Greg Creech, P. O. Box 
1431, Pine Lake, GA  30072-1431, www.gregcreech.com or www.gregcreech.biz.  

  

http://www.gregcreech.com/
http://www.gregcreech.biz/
http://www.gregcreech.biz/
http://www.gregcreech.com/
http://www.gregcreech.biz/


Greg Creech  Page 3 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

 

PowerPoint Pizzazz!  Oops & Legal Stuff .................................................................................................................... 2 

Table of Contents .......................................................................................................................................................... 3 

Introducing Greg Creech ............................................................................................................................................. 6 

Welcome to PowerPoint Pizzazz! ................................................................................................................................. 7 

Who’s Running The Show, Anyway? .................................................................................................................... 7 

Our Presentation ........................................................................................................................................................... 9 

Important Options and Notes ............................................................................................................................... 10 

Title Slide – Slide 1 ..................................................................................................................................................... 11 

What A Great Opening! ........................................................................................................................................ 11 
Step 1: How to create a new presentation and Title Slide.................................................................................... 11 
Step 2: How ‘bout That – Time to Format! ......................................................................................................... 12 

Slide Two: A Bullet List .............................................................................................................................................. 14 

Dodging the Bullet with Animation ...................................................................................................................... 14 
New Slide and Layouts ........................................................................................................................................ 14 
Headers and Footers ............................................................................................................................................ 15 

Don’t Hesitate, Let’s Animate .................................................................................................................................... 18 

Custom Animation and the Animation Pane ....................................................................................................... 19 
Animating Bullets and the Task Pane .................................................................................................................. 19 

Animation – Special Effects .................................................................................................................................. 24 
Animating a Title Slide – Show Time Folks! ...................................................................................................... 24 
PowerPoint 2010/2013 Animation Tab ............................................................................................................... 28 

Animation Painter ................................................................................................................................................. 29 
Removing or Deleting Animation ........................................................................................................................ 30 

Slide Transition ........................................................................................................................................................... 31 

Transition Tab ....................................................................................................................................................... 32 

Reusing Slides and Layout Changes .......................................................................................................................... 33 

Slide Three: Title, Text, and Clip Art/Pictures .......................................................................................................... 34 

A Whole Lot Going on Here ................................................................................................................................. 34 
First The Title ...................................................................................................................................................... 34 
Second the Text ................................................................................................................................................... 34 
Third the Clip Art ................................................................................................................................................ 35 
PowerPoint 2013 Online Pictures ........................................................................................................................ 36 

Time to Animate the Slide ..................................................................................................................................... 36 

Animation Order and Re-Ordering ..................................................................................................................... 38 

Slide Design ................................................................................................................................................................ 39 

Themes .................................................................................................................................................................... 39 



Greg Creech  Page 4 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

Color Design ........................................................................................................................................................... 40 

Font Themes ........................................................................................................................................................... 41 
PowerPoint 2013 – Design Notes ........................................................................................................................ 41 

Slide Four:  Chart Slide ............................................................................................................................................. 42 

Very Smart, It’s a Chart! ...................................................................................................................................... 42 

Creating a Chart .................................................................................................................................................... 42 

Chart Design Tab ................................................................................................................................................... 44 

Chart Layout Tab .................................................................................................................................................. 45 

Chart Format Tab ................................................................................................................................................. 47 

Chart Animation .................................................................................................................................................... 48 
Chart Animation – PowerPoint 2007 ................................................................................................................... 48 
Chart Animation – PowerPoint 2010/2013 .......................................................................................................... 50 

Slide Five: SmartArt ................................................................................................................................................... 51 

Creating a Diagram ............................................................................................................................................... 51 

SmartArt Design Tab ............................................................................................................................................ 53 

SmartArt Format Tab and Shortcut Menus ....................................................................................................... 54 

SmartArt Conversion ............................................................................................................................................ 56 

SmartArt - Diagram Animation ........................................................................................................................... 57 
SmartArt Animation in PowerPoint 2007 ............................................................................................................ 57 
SmartArt Animation in PowerPoint 2010/2013 ................................................................................................... 58 

The Photo Gallery ....................................................................................................................................................... 59 

Important Photograph Gotchas! .......................................................................................................................... 59 

How to add a picture. ............................................................................................................................................ 59 

Photo Gallery Slide ................................................................................................................................................ 60 

Format Picture Tab ............................................................................................................................................... 61 
Artistic Effects on Photos .................................................................................................................................... 62 
Enhancing the Picture .......................................................................................................................................... 62 
Screenshots and Screen Clipping ......................................................................................................................... 64 

Sound, Movies, Action! Multi-Media ......................................................................................................................... 66 

PowerPoint 2007’s Sound Options Tab ............................................................................................................... 67 

PowerPoint 2010/2013 New Playback and Format Tabs.................................................................................... 67 

Inserting Audio/Video Files .................................................................................................................................. 68 

Music, Narration, or other Sound from a File .................................................................................................... 68 

Clip Art and Online Media ................................................................................................................................... 71 
PowerPoint 2007 and 2010 Clip Art Sound ......................................................................................................... 71 
PowerPoint 2013 Online Audio ........................................................................................................................... 72 

You’re in the Movies ................................................................................................................................................... 72 

Video from Web Sites and Online Videos – PowerPoint 2010/2013 .................................................................. 75 



Greg Creech  Page 5 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

Action, Action We Want Action - Action Buttons ...................................................................................................... 78 

Linking and Embedding Objects and Files ................................................................................................................ 82 

Linked Files ............................................................................................................................................................ 82 

Inserting as an Object ........................................................................................................................................... 84 

Copy and Paste an Excel Chart ............................................................................................................................ 85 

Templates and The Master ......................................................................................................................................... 86 

Master View Tabs .................................................................................................................................................. 87 

A Custom Theme and Template ........................................................................................................................... 89 
First:  A Background. .......................................................................................................................................... 89 
Second:  A Color Scheme .................................................................................................................................... 91 
Third:  Font Formatting ....................................................................................................................................... 92 
Fourth:  Bullets .................................................................................................................................................... 92 
Fifth:   An AutoShape, Logo, or Picture .............................................................................................................. 94 
Sixth:   Animation for a Title ............................................................................................................................... 96 
Seventh:   A Custom Layout ................................................................................................................................ 96 
Finally:  Headers and Footers .............................................................................................................................. 97 

Template ...................................................................................................................................................................... 98 

Themes ...................................................................................................................................................................... 100 

Now to Practice .................................................................................................................................................... 100 

PowerPoint Show ................................................................................................................................................. 101 

An Invitation or Greeting Card .......................................................................................................................... 101 

Kiosks or Stand Alone Presentations ................................................................................................................. 102 

Narration/Rehearsed Presentation Overview ................................................................................................... 103 

Presenter View – 1 Show and 2 Monitors .......................................................................................................... 105 

Handouts/Notes .................................................................................................................................................... 106 

Photo Album ........................................................................................................................................................ 106 

PowerPoint’s View Tab ............................................................................................................................................ 108 

PowerPoint’s Print Preview and Print ......................................................................................................... 112 

 ................................................................................................................................................................................... 113 

Powerful Index of PowerPoint ................................................................................................................................. 114 



Greg Creech  Page 6 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

Greg Creech 
sings to his 
students, and 
often he 
performs stand-
up comedy about 
computers. 

Shop Talk from The Atlanta Journal-Constitution 
Sunday, Oct. 29, 2000 R3 - JOBS 

Why I Love my Job – Greg Creech 
What I Do: I teach technology courses and make presentations to beginner and expert computer 
users and professionals.  I use humor and the piano.  
I train all levels from first-time computer users to 
systems technicians acquiring A+ certification.  As an 
A+ certified trainer, MOUS expert, and technical 
trainer, my certifications and knowledge give me a 
career in the technology.  My humor, the piano, and 
people keep me in the technology training field. I 
sing to my students sometimes and perform stand-
up comedy about computers. 
How I got started:  I won Best Actor in a Supporting 
Role at Southside Theatre Guild for “A Funny Thing 
Happened on the Way to the Forum” and studied 
comedy under Jerry Farber.  I have played the piano 
since 8 years of age and had the first personal 
computer with a 1 MB of memory.  In order to learn 
the PC, I associated the PC with the piano  -- both 
use a language to translate, both have keyboards, 
and now - both provide music and information.  I 
must admit I miss the days when I only played the 
piano and programmed the PC.  Now, I play the PC 
and have to program my piano.  In 1998 after 
seventeen years of technology business experience 
in the corporate market, I decided to take a leap of faith on my own. I call my 
presentations “Showminars,” a combination of a show and a seminar. 
The Best Part:  Hearing the laughter and the comments:  “You have saved me so 
much time,” and “I remember complicated macros because of the way you taught 
them.” I have a passion for teaching creative people to be more technical and 
technical people to be more creative – Mozart would be proud! 
The Challenging Part:  Explaining why I want my piano in a PC classroom.  
“Mainframers” who refuse to acknowledge the existence of the PC and the Web.  
People who attend training classes because they have to, not because they want 
to.  Technical people who are not client- focused. 
My Favorite Quotes:  “To err is human, to really mess things up you need a computer.”  “Forty-two 
percent of all households have a computer; only eight percent of those know how to use it.”  
What Keeps me Going:  I enjoy combining my love of people, the piano, processors, and humor into a 
unique speaking and learning experience. 

Technology 
speaker and 
trainer 

Speakin' & 
Geekin' 

Pine Lake 
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Welcome to your course on the ®! PowerPoint is a great presentation Power of PowerPoint
application from Microsoft Corporation and is included in the Office Suite of products.  
PowerPoint is an effective and entertaining way of presenting information.  Since we are in the 
Information Age, use PowerPoint any time you want to display information.  From invitations 
and greeting cards to education and motivation presentations, PowerPoint is for you and our 
Age of Information.  Whether in an auditorium, kiosk, classroom,  or courtroom PowerPoint is 
everywhere.  There are tons of great applications for using PowerPoint and we will examine 
many of them in this course. 

We will have fun and learn – a process I entitle “ ”, so we will “flurn” .  Of all Flurning PowerPoint
of the applications in which I work,  is the most entertaining and fun that I can have PowerPoint
with a computer short of playing Solitaire or other games.  You will find that  is the PowerPoint
most fun you can have and stay in the Office Suite. 

This course combines the introductory, intermediate, and the advanced functions of 
PowerPoint into one handy, dandy document.  I’ll provide presentation tips, too. 

Who’s  Running The Show, Anyway?  
Although PowerPoint is powerful, the application does not replace the presenter, trainer, 
speaker, salesperson, or any other person using PowerPoint.  PowerPoint is a vehicle to 
accentuate your message and help educate others on your material.  I have witnessed too 
many professionals overwhelm and bore audiences with too much text, animation, shocking 
colors, and the list can go on.  Word is designed for manuals and documents with lots of text; 
PowerPoint is designed for listing text and using lots of graphics and movement. You tell the 
story; you relate the information; you are the true power of PowerPoint.  PowerPoint is your 
assistant, your helper, and your documenter.  If PowerPoint tells and displays the entire 
message and information, who needs you?  Just give the handout and go home.  No way!  A 
machine can never replace your voice, your look, and your original style of presenting; 
however, a machine can help you strengthen your information and enhance your style of 
presentation. 

I will provide helpful presentation tips and design tips that training materials, fellow presenters, 
my theatre and presentation history have taught me.  Also, I am a member of the National 
Speaker’s Association and Association of Talent Development.  If you seek training and/or 
speaking as a profession, please consider joining these outstanding organizations.  Both 
organizations are excellent sources and resources of presentation tools and tips.  Here are 
some design and presentation tips to keep in mind as we build our presentations. 

 No more than six (or so) words per line, 

 No more that six (or so) lines per slide, 
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 Use sans serif fonts – fonts without little strokes - (Tahoma, Arial, Moderne) for Titles, 

Headings – sans serif fonts bring a attention, Notice that most business and road signs 

are sans serif,  

 Use serif fonts (Times New Roman, Georgia) for Bullets and multiple text lines – serif 

fonts help our eyes read and reduces eyestrain, Notice that most magazine articles 

and books are written serif fonts, 

 No more than two or three fonts per presentation, 

 Avoid bright colors as backgrounds, use bright colors to accentuate or enhance your 

presentation, 

 Customize – avoid the templates in PowerPoint (Most business people have seen all of 

these templates) – use your creativity to develop your own template and style.  This 

course is designed to help you accomplish customization, 

 Avoid using too many fonts (generally a maximum of 3) in a slide show or 

presentation, 

 Use graphics to re-enforce your message and cartoons to invoke humor, 

 Use animation for disclosure – displaying one bullet item at a time, 

 Do not use PowerPoint to write a book, 

 Do not over use the color Red – people literally see Red and emotionally feel 

uncomfortable if you use too much Red in your presentation, Green will make people 

think of money, Bright Yellow will evoke weakness, Orange induces hunger, etc. 

 If you provide handouts, wait until the end of your presentation to distribute them – 

the sound of rustling paper is not pleasant and your audience will concentrate on the 

written word not your spoken information Slide 2 
 

We will build a presentation using many of the types of slides and will learn new items as we 
build each slide and add functionality and enhancements as we go.  We will begin with a title 
slide, build a bulleted list, and many other types of slides, including slides with photographs, 
diagrams, and charts. 

We will construct our first presentation with a blank background for us to customize through 
Microsoft’s templates and then our own custom template.  I will overview the slides that you 
will be preparing.  I believe that designing your own color schemes, logos, and other 
customization techniques will help your creativity, impress your audience, and illustrate your 
presentation and message better.  PowerPoint is an invaluable branding tool for your 
organization, too, and knowing how to customize and manipulate PowerPoint can help in your 
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branding and creativity. You’ll be self-sufficient, too. Also, the world will know you took a class 
from me and I will be proud of your originality.   

Enjoy the process of “flurning” the Power of PowerPoint.  I know I will enjoy teaching you.  
Now, as we say in theatre and presenting: On with the (slide) show! 

 Write your notes here: _____________________________________ 

___________________________________________________________ 

___________________________________________________________

Let’s get started with building our own presentation. PowerPoint is much more than a screen or 
“live” presentation tool. I encourage you to type in your own information and begin building a 
presentation to fit your needs and your applications.  I will offer text for you to type, of course, 
but you’ll get a lot more out of this course if you use your own imagination and wording.  We 
will use logos, pictures, videos, music, and all types of multimedia for your presentation; you 
should know where these items are located prior to our inserting, customizing, and displaying 
them in our slide show.  So, go ahead and start collecting your logos, pictures, etc. for our 
time together, now.   

Also, don’t worry that your presentation is plain and boring looking.  We will change that later 
in our third slide.  We will use some of PowerPoint’s design templates and we will design our 
own design templates later in the course.  We will also create our own logos, color schemes, 
and other nifty PowerPoint formatting and design features, but first we need slides and 
information in which to work so let’s start building the presentation and our fantastic slide 
show! 
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Important  Options and Notes  
You should activate your PowerPoint Options Pane and review these items, especially the 
Advanced item that may want to change your number of Undos from 20 to 150 (the maximum) 
and have a default view for opening your prentation. 

 A Hot Tip! You may change your 

Normal view panes in the PowerPoint 

Options located in your Microsoft Office 

Button menu.  Clicking the PowerPoint 

Options button activates the Options 

menu. As displayed at right and in the 

Options menu, the Advanced section of 

your PowerPoint options contains a 

section entitled Display.  In the Display 

section, you will notice “Open all 

documents in this view:” Mine is set 

with Normal: Thumbnails, notes, and 

slide.  You should set this according to 

the panes you like in your Normal View. 

Also, notice this is where you may increase your Undos from 20 to 150.  I 

need this very badly and wish we could increase the undos in PowerPoint to 

1050!  

 Using Slide Sorter View or your Thumbnails pane you may copy a slide to a 

new location, too by pressing your CTRL key and drag the slide another 

location.  Or you may press your CTRL + D Keys to duplicate the slide - this 

accomplishes Copy and Paste in one easy to use step!   
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What A Great  Opening!  

Step 1: How to create a new presentation and Title Slide. 
At the Start-up of PowerPoint, you are at the Title Page of a New Presentation, if you are 
already in PowerPoint,  

1. On the Microsoft’s Office 2007 button’s Menu click New or Double Click 

Blank document to start a new presentation.  In Office 2010 and 2013, 

you use the File tab to create a new presentation. You may press the 

CTRL + N key to start a new presentation, too.  

 At the Title Page of a New Presentation – 

2. Type the title The Power of PowerPoint or type your own title.  Click to 

the Next Title area of the screen.  DO NOT PRESS ENTER. 
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 An Important Gotcha!  A common and frustrating mistake (and habit) for all of us using 

PowerPoint is pressing the Enter Key. The Enter Key produces more space in your Text box 

and does not move you to other areas of your slide.   

 I click from area to area.   

3. Then Click in the secondary title area and type:  Your own sub title or 

type Your Name on one line, press enter, type your Title on the second 

line and press enter. Type your slogan or a phrase on the third line, as 

displayed on the previous page. 

 

Step 2: How ‘bout That – Time to Format! 
Let’s use the Formatting buttons on the Home Tab.  After entering information in the title 
areas.  

 Hot Tip! While we are learning formatting here, you should avoid this type 

of custom formatting until you have determined your final design for the 

presentation. Which we will accomplish later. The formatting that you 

accomplish here overrides the design that you choose later. When we want 

to create our own design and template, we will use the formatting items in 

our Slide Master view.  

 

Click the Main Title Area or Box to receive a sold line around your text as 

displayed below.  

 Important Notes About your Text 
Boxes : 

 Small circles surround the area for you 

to click on to drag in or out to resize the 

title.  Dragging in will make your text box 

smaller and dragging out will make your 

text box larger.  I like using the corner 

circles to change the height and the width 

of the Text box at the same time. 

 You may click the border of the text 

box to select the entire text boxes – a 
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solid line will surround your box. This solid line indicates that your entire Text box is selected 

and any changed you make effect everything in the text box.  This is a convenient tip to know 

in working with the many objects in PowerPoint.  

 A four headed arrow will alert you that you have the text box selected; the four headed 

arrow allows you to move your text box. 

With the four headed arrow you may click and drag the entire text box to another area. Click 

on the border of your object usually produces the four headed arrow.  

 If  a solid line surround your text box you can apply formatting to all of the text at once.  If 

a dashed line surrounds your text box, you will need to select the text you wish to format. 

 The green circle is free rotate. Clicking and dragging this around allows you to change the 

position of your text box, Clip Art, picture, and other objects. 

 

1. With a solid line surrounding your text 

box Title and using your Home Tab’s 

Command buttons in the Font Group, 

Click the Bold, the Italic, and Shadow 

Buttons as pictured here.  (ScreenTips will 

appear as you move your cursor over the 

buttons to inform you of the purpose or 

name of the button).  Make other changes 

as you like. 

2. Next click in the sub-title text box, notice 

that PowerPoint changes the border of your text box to a dotted or 

dashed line.  You will need to select the text you wish formatted. Select 

all of your text and format the text using the Mini  Toolbar.  The Mini 

Toolbar should appear 

after you select your text 

and move your cursor 

upward.  If the Mini 

Toolbar doesn’t appear, 

right click on your text 

and the Mini Toolbar will 

appear with your shortcut 

menu. Using the Mini 
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Toolbar change your font, font size, and color. 

3. Move your cursor to the border of the Text Box and use the four 

headed arrow and click and drag your title box(es) to a new area of 

your slide.  Click the Undo button if you need to put your text box back. 

  

Yeah!  The First screen known as the Title Slide is complete. We will animate and enhance this 
slide later.  

Click the save icon or press the CTRL + S keys and save your file as 

PowerPoint 1. 

Now, onto Slide Two! 

Dodging the Bullet  with Animation  

New Slide and Layouts 
Time for a new slide.  Slide Two will be a bullet list in a text box.  To create 
a new slide, we will click the New Slide command button and from the 
menu select the type of slide we wish – we will use Title and Content for 
this slide and subsequent slides for our presentation. 

Here’s how to create a bullet – text slide: 

1. On the Home Tab, Click the New Slide button and 

from the menu click the Title and Content slide from 

the gallery. 

2. Click on the Title area and type your own Heading or 

type “Bullet and List Guidelines”. 

3. Click in the Bullet area and type a line of information. 

I have typed:  Primary Bullet Level (1st Level). 

4. Press Enter. 

5. Another Bullet appears, Press Tab key, A Secondary 

Bullet appears.  Type another line of information.  I 

have typed: Secondary Bullet Level (2nd Level). 

6. Press Enter 

7. Another Secondary Bullet appears, Press Shift AND Tab keys 

simultaneously, A Primary Bullet Appears. 

8. Press tab twice to produce a Third level bullet. 
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9. Press Shift tab to go up a bullet level to level two  and type your own 

information or type Another Secondary Bullet Level. 

 Tabbing with your bullets demotes your bullet and Shift 

Tabbing promotes your bullet level. You can also use the Increase 

and Decrease Indent Icons (pictured at right) on the Home Tab’s 

Paragraph Group to make various bullet or list levels.   

 

1. After entering your first three 

bullets, press enter. 

2. Press the Decrease Indent Icon 

twice OR press the Shift key and 

keep it press and press the tab key 

twice to return to a Primary (First 

Level) Bullet. 

3. Continue to add Primary (First 

Level) Bullet items and press enter 

at the end of each bullet to create 

a new bullet.  Here are my bullet 

items for this slide: 

 No more than six lines per 

slide 

 No more than six words per line 

 Minimum font size - 28 

 Use disclosure on your text/bullets 

slides 

Headers and Footers 
Let’s add Footer information at the bottom of the page.  The 
Footer can contain information such as date, time, page 
number, author, etc.  Here are the steps to add a Header and 
Footer with the screen pictured at right. 

Click the Insert Tab and then click the Header & 

Footer button – the Header and Footer dialogue 

box opens as displayed at right.   

Examine the Dialogue Box and note that you can add a Header 
and Footer to Slides (First Tab) or Notes and Handouts 
(Second Tab) For an example of the Notes and Handouts 
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Header and Footer look at the Handout from PowerPoint that accompanies this manual. 

1. Click on the Slide Tab, ensure Date and Time are selected by clicking a 

checkmark in the box. 

2. Ensure the Update Automatically Radio Button is selected so when you 

show this presentation the current date and time on the computer will 

display here, then using the Drop Down box select the format of your 

date and/or time or enter other text or date that won’t change 

3. Ensure that Slide number is selected with a check mark. 

 A Hot Tip! Having a slide number on your slides is great unless you hide 

a slide then the slide numbers will skip – we will learn how to hide slides 

later – Keep in mind that when you hide a slide the slide number displays 

and doesn’t renumber your slides.  

4. You may type in your own Footer just type in the box your information.   

5. Also, you should check the “Don’t Show on Title Slide” check box;  the 

Title Slide should be clean and neat without a Header and Footer.  

6. Then click Apply to All Button.  

 

You should use the Headers & Footers Notes and Handouts Tab too as 

displayed below.  A picture of my presentation as a handout in Notes Pages 

view appears here with the header and footer.  
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Test your Headers and Footers and let PowerPoint automatically update your date 
information based upon when you are working on your document. 

1. Navigate to your Title Slide and notice that Header and Footer is not 

there. 

2. Click your save icon or Press the CTRL + S keys after working on each 

slide. 

3. Also, Click the Slide Show View button on your Status Bar 

to see how your slide show will appear during your 

presentation.   

4. OK – Not very impressive yet, but we are about to start 

changing that.  Let’s use animation to bring the title in 

automatically and then to bring in each bullet separately. 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________  
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Animation is an important and fun feature to learn in PowerPoint.  We will spend a lot of time 
on Animation and using the various features in PowerPoint’s Animation.  While you can 
certainly go overboard and drive your audience crazy with all of the dizzying and eye catching 
animations, I encourage you to use a lot of the animation features and to go “overboard” as 
you learn.  In your “real” presentations, your animations should be appropriate and add to your 
presentation’s movement and practicality.  Don’t let PowerPoint’s animations upstage you, 
your message, or the content of your presentation.  You should be consistent in the animations 
of your titles and other objects that repeat in PowerPoint and you should use animations to 
facilitate the ease of presenting with PowerPoint and not let PowerPoint overpower you and 
your message. 

Animation is very important to bullet list and text in PowerPoint.  You want to bring in each 
bullet item separately.  This is termed progressive disclosure in the training industry.  Using 
progressive disclosure allows to speak on each item and to have the audience focus on that one 
item as you speak.  If you don’t animate your bullet list, the audience will be overwhelmed with 
the amount of information.  For the past several years Corporate  Americans have been taught 
to concentrate on the “bottom line” and that is exactly what most of us will do in a 
presentation that does not use animation.  Subconsciously we will pay attention to the last item 
on the bullet list.  Our focus is distracted and your spoken message will not have the impact and 
the attention that each bullet deserves because of the number of bullets.  Animation corrects 
this and provides a practical, efficient, and entertaining way to keep and enhance your message 
and the audience’s attention and focus.  

Custom Animation in PowerPoint 2007 is necessary in not only animating your items and 
objects in PowerPoint and accentuating your message but also in creating and editing 
multimedia’s components of PowerPoint such as music, sounds, and videos, which we will learn 
later.  Learning Custom Animation early in our education of PowerPoint is important in keeping 
you awake and interested in PowerPoint, and Custom Animation will help us as we continue 
learning other types of slides and multimedia.   

Animation is movement within a slide; transition is movement between slides. We will use 
both to add pizzazz to our PowerPoint. 

PowerPoint 2010 and 2013 has the Animation Tab and the Transition Tab, PowerPoint 2007 
has the Animation Tab. The Animation Tab was too much on one tab in PowerPoint 2007 so 
now we have two tabs in PowerPoint 2010 and 2013 with which to work.  Also, the Custom 
Animation pane in previous versions of PowerPoint is now called the Animation Pane.  

So, Don’t Hesitate, Let’s Animate! 
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2007 Animation 

Tab and Pane  

2010 Animation 

Tab and Pane  

Custom Animation and the Animation Pane  

Animating Bullets and the Task Pane  
You will need to use the  to customize your animation further than what we Animation Pane
may accomplish using the Ribbon and the . The  and Animatin Tab Animation Tab Animation 

 for PowerPoint  and the  and  for PowerPoint Pane 2007 Animation Tab Animation Pane 2010 
 appears below, too.  Choosing and adding Animations is easier in 2010/2013 because and 2013

many of the useful and popular animation display as a button on your Animations tab and the 
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Effect Options and Add Animations buttons make modify and editing your animation simpler. 
Also, in PowerPoint 2010/2013 you may use your new feature the Animation Painter to copy 
your animations throughout your presentation.  We will learn these items later. 

Let’s add animation to our bullet slide so each enters separately. We will use PowerPoint 
2007 first and then use PowerPoint 2010/2013. No matter the version you should activate 
your Animation Pane. 

1. Click in the Bullet area and from the PowerPoint 2007 

Animations tab click the Custom Animation button. 

2. The Custom Animation Task Pane opens at the right of your 

screen. 

 

 Hot Tip! PowerPoint places numbers next to your animated items.  The 

numbers are for manual animation and is the number 

of clicks or other way of bringing in your animated 

objects.  For Example, the first click will bring in the 

the Primary and Second bullet.   

3. In the Custom Animation Task Pane click the Add 

Effect button’s arrow and from the list choose 

Entrance. From the Entrance menu, choose More 

Effects… 

4. Next, notice all of the neat animations you may 

use. As you click or select an animation in the 

background, the animation demonstrates the animation 

on your text if you have the Preview Effect item checked 

at the bottom of the dialogue box as I have here.   

5. Explore the different entrance you may give. I am 

choosing the Subtle entrance effect of Fade 

6. After choosing your animation, click OK. 

 

 Hot Tip! While there are many appropriate animations in 

PowerPoint you should avoid any animation that spins or 

rotates as you and your audience will get sea sick. These 

animations include Pinwheel, Spinner, and others that you will 

discover as you work with PowerPoint’s fantastic animation and 

movement options.  
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PowerPoint 2010/2013 uses the Animation Tab to accomplish tasks that were previously in the 
Custom Animation pane, which the Custom Animation Pane becomes the Animation Pane in 
2010/2013 PowerPoint.  

  

1. Using 

PowerPoint 

2010/2013, 

click in your 

Bullet list on 

your slide and 

from the Animation tab click the More button circled above. While I 

could have chosen an animation effect in the Animation group, I want 

you to see all of the Entrance effects that are available.  

2. The More pane and gallery of 

animation effects for 

Entrances, Emphasis, and 

Exits appears for you to 

select the animation. Click 

the More Entrance Effects 

item.  

While you may bring in items 

including photos, charts, text, and 

other objects, you may add emphasis and exits, too. I will 

concentrate on bringing in my information and objects and 

having them stay on the screen. 

 

3. The Entrance Effects selection pane appears for you and as 

you click or select an effect, PowerPoint demonstrates the 

animation in the background on your text. You should have 

the Preview Effect box checked at the bottom of the screen 

to sample the effects on your text.  I am choosing Fade, so 

choose your effect and click OK. 
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Now, back in your slide, PowerPoint numbers the bullets and items for you.  

1. Put your slide in Slide Show view and press enter or click to advance 

the bullets.   

2. Notice that PowerPoint displays your Primary and Secondary bullets. 

We want to bring the bullets in separately.  

3. Let’s press the ESC key to return to our Normal view.  

Now, we need to spend time with important effect options and timing. 

 

1. Using PowerPoint 2007 click your Custom Animation 

button or in PowerPoint 2010/2013 click your 

Animation Pane button. In your Animation Pane notice 

these options as we will use them extensively 

throughout our course.   

2. Click the arrow next to your Content Placeholder 

animation as displayed above and from the menu scroll 

to the Effect Options. . . item and click. 

3. At the Next Dialogue box, Click the Text Animation tab. 

4. By default, in the Group Text box By 1st level 

paragraphs displays.  Using the Drop Down arrow for 

this list, scroll and Click By 2nd  level paragraphs.  

Since we are using two bullet levels and want each 

bullet level to enter independent of the other we need 

to choose this option. 

5. Next Click the Effect Tab. 

6. In After animation: Change the color to a light gray. 

7. In the Animate Text: Change this to By Word from the 

pick list. 

8. We won’t add a sound at this time. 

9. Click OK. 

 

Why did we change these settings?  We want to emphasize each bullet and 
to ensure that focus remains on that item and changing the After animation 
color will accomplish this.  We changed the Direction and Animated text By 
word to illustrate the ability to manipulate the animation schemes which we will accomplish 
many times in this course. 
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1. PowerPoint should display a preview of your animation, if not Click the 

Preview Button to view your slide’s animation. 

2. Click the Slide Show button and press enter for each bullet to appear.  

Notice the 1st and 2nd level bullets are now entering separately and 

that the text will gray out as you bring in a new item. 

3. After the final bullet item, press the ESC key to return to your Normal 

view of the presentation. 

 

Thankfully, the Effect Options, Timing, and Animation tabs in the 

Effect Options dialogue box does not change much in 2007, 2010, and 

2013 versions of PowerPoint. In 2010/2013 PowerPoint you may 

change your effect options using the Effect Options button on your 

Animation tab to control the animation. Notice at right my selection is 

By Paragraph for the effect; however, PowerPoint still only uses the 

default of 1st level paragraphs so I must use my effect options 

dialogue box and the Text Animation tab to change my 

bullet animation to 2nd or 3rd level paragraphs. Also, to 

dim or change my text color as I move from one bullet to 

another requires that I use the Effect Options dialogue 

box and not the Animation Tab in the Ribbon. 

 

 

In 2010/2013 PowerPoint you may use the Add 

Animations button to insert animation onto your text and 

objects, too. However, you will still need to use the Effect 

Options dialogue box to tailor your animation to fit your 

needs. 

 

 

 Write your notes here:________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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Animation  –  Special  Effects  

Animating a Title Slide – Show Time Folks! 
 

As a presenter, I like to concentrate on the audience and not on PowerPoint to begin the 
presentation. You only have a few seconds to establish a relationship with the audience and 
you want to focus the them and not starting your presentation and wasting time clicking and 
looking at the computer or screen. I like to have my Title Slide completely automated, so when I 
begin the presentation I can concentrate on the people and not on PowerPoint. I let 
PowerPoint do all of the work as I welcome the people and let them know up front of the 
advantages and benefits of the presentation.  

Here is the method of Animation in 2007 PowerPoint. 

1. Click your Main Title Text Box on your first slide.  On your text box a 

sold line border and small circles surround 

the text box signifying it is selected.  You 

can resize your object by getting the 

double arrow when your cursor is position 

in a circle and click and drag to make the 

text box bigger or smaller.  The green 

circle is the rotation circle.  You may rotate 

the object by clicking and dragging the 

green dot.   

2. From our Animations Tab, Activate your Custom Animation Task Pane.   

3. With your text box selected, Click the 

Add effect button.  From the Cascading 

menu trace to Entrance and in the next 

Cascading menu trace to More Effects 

and click.   

4. Click the Effect you wish to use.  If you 

checked the Preview box at the bottom 

of the Task Pane, the effect will play for 

you. 

5. I have chosen Flip in the Exciting 

section of the Entrance Effect and 

PowerPoint is displaying the animated 

text at right. 

6. After deciding upon your effect, click OK. 
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7. Back at the Custom Animation pane, click in the Start 

box and from the menu  Click the Start With Previous 

– this will animate our text automatically when the 

slide show begins.  We will use the Start After 

Previous in the next section as we animate the Sub-

Title.   

 

 

More Effects and Options -  
1. Next, Click on your drop down arrow for the Title again, and click 

the Effect Options . . . button.  The dialogue box pictured at right 

appears.  Using the drop down arrow for the Sound choose a 

humorous sound for your title, I have chosen Applause.  Unlike 

the Bullet list we created and animated 

earlier, I do not want the Title to dim so 

leave this on Don’t Dim. 

2. Next Click the Timing Tab of this dialogue 

box; the Timing tab is pictured below at 

right.  Our previously selected With 

Previous item appears in the first Start 

box.  I don’t want a delay with this; 

however, I have changed speed to 2 

seconds (Medium)  and I do not want this 

to repeat – I have left this to (none). 

3. Click OK 

4. At bottom of the Custom Animation Task 

Pane, Click the Play button and watch the 

magic of your animation at work.  This is 

neat, entertaining, and will help keep your 

audience awake as they begin to watch your 

presentation. 

5. After your animation plays, Click the Slide 

Show icon and notice that your animation 

begins automatically without a click of a 

button or pressing enter.  Your sound should 

play, too. 
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6. After the animation is completed, press the ESC key on your keyboard 

to return to the normal view to animate your sub-title. 

 

Even More Effects and Options -  
1. On your Title Slide, Click in your Sub-Title 

text box and ensure the text box selects.  As 

we accomplished previously, we will add 

animation to this text box and have it play 

automatically for us.  

2. With your Custom Animation Task Pane 

active and your Sub-Title Text box selected, 

Click the Add Effect Icon.  In the cascading 

menu trace to Entrance and in this Cascading menu click the More 

Effects item. 

3. I have scrolled down to the Exciting area and clicked 

Spiral In.  With the Preview Effect box checked at the 

bottom of the dialogue box the Effect will play for you 

when you click it.  You may need to move the Add 

Entrance Effect dialogue box in order to view your 

animation to do this – click on the title bar of this box 

and drag it away from the area of your animated 

slide.   

4. Click a few of the effects and finally choose one you 

like and Click OK. 

5. Click the Play icon to view your animation.  

6. Our newly added animation to the sub-title text will 

work on Mouse Click or pressing enter, let’s change 

this so that the text will animate automatically after our Title 

Text. 

7. Click the drop down arrow next to your animation and click 

the Start After Previous item as pictured at right. 

8. Change your Speed to Medium. 
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1. Now, Click on the Drop Down arrow for your Subtitle 2 

Animation. 

2. From the menu, click the Timing. . . option. 

3. From the Timing Tab, I have entered a Delay of 2 

seconds after the Title Text completes its animation and 

between each line.   

4. Next click the Effect Tab and change the 

Animate Text by Word. 

5. Click OK.  

6. Click the Play Icon  

7. Watch your Animation and if all is well Click the 

Slide Show icon and watch your Title Slide play 

itself automatically. 

8. After your title slide completes its animation 

and is in view. Click or press enter to view your 

second, bullet list slide. 

9. Preview your bullet list. 

10. After this completes, press the ESC key 

to return to your presentation to add our 

third slide. 

 

I like to have my title slide completely automated and for it to 
play as the audience prepares for the presentation.  I’ll show 
you later how you can set up this slide to repeat endlessly.  I like to set-up my laptop with the 
projection system at least 15 minutes before the presentation begins and have the title slide 
repeat welcoming people to the presentation. 

For Practice and using the above pages as a guide, Animate your 

Title on your second slide to come in automatically (With 

Previous) using the animation entrance of your choice. My Zoom 

Entrance for my second slide’s title and its properties are 

displayed at right.  I used my Re Order arrows at the bottom of 

the screen to change the order my Content being first to the Title 

1 being first in my list.  

Press the F5 key on your keyboard to preview your Slide Show 

from the beginning.  Save your file. 
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PowerPoint 2010/2013 Animation Tab 
Since PowerPoint 2010/2013 separates the Animation and Transition Tabs, 
animating is easier using the command buttons on the Animation tab than using 
previous versions and the Effect Options dialogue box.  

After selecting your Entrance effect on the Animation tab, you will use the Effect 
Options button and menu frequently. The Effect Options menu changes based on the 
type of Animation that you select; different animations have different options and 
different object have difference options, too. For example, when you Animate text 
you may do so As One Object, All at Once, or By Paragraph as displayed at right. 
When you animate a chart, SmartArt, or other graphical item you receive other types 
of effect options.  

The Advanced Animation and Timing Group in the Animation Tab replaces some of 
the items that required the Custom Animation Pane. As I wrote earlier, the 
Animation Pane in the Advanced Animation group replaces the Custom Animation 
pane in previous versions of PowerPoint. The Animation Painter is a new, terrific feature in 
2010/2013 PowerPoint that allows you to copy your animation from one object and use the 
same animation and settings to other objects; this is a big time saver and works similar to the 
good, old Format Painter. Items such as starting your animation on click, With and After 
Previous, Duration, and Delays are on your Ribbon and these groups and not the Animation 
Pane.  You may rearrange your animation using the Timing group, too. These groups appear 
below and we will use these items as we further animate our presentation’s objects. 

 

 

 

 

 

 

 

 

Here is the method of Animation in 2010/2013 PowerPoint for animating a Title Slide so it 
complete automates for you. 

1. Click your Main Title Text Box 

on your first slide.  On your 

text box a solid line border 

and small circles surround the 

text box signifying it is 

selected.   

2. Using the Animation tab 

choose an effect, I’m using Fly 
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In. Next using the Effect Options button and cascading menu, I have 

changed the direction from Bottom to Top.  

3. Using the Timing group, I am starting my title’s 

animation With Previous so the title animates when 

I begin the presentation. I am slowing the animation 

using the Duration box and I do not want to delay 

the animation from the time my PowerPoint 

presentation begins.  

4. After making these changes, click your Slide Show button to view the 

totally animated title. After viewing your title’s animation, press the 

ESC key to return to your Normal. 

Animation Painter  
New to PowerPoint 2010/2013 is the Animation Painter. Similar to 
the Format Painter in the Office Suite, PowerPoint 2010/2013 has the 
Animation Painter which allows you to select an Animation and apply 
the Animation to other items and objects.  Click in your animated Title 
Box and Click the Animation Painter. 

 Hot Tip! When you click the Animation Painter once, 
PowerPoint copies your animation once to another 
object. When you double click the Animation Painter, the 
painter stays on and applies the animation on objects 
that you click. So copying animation from one object to 
multiple objects and slides is a great time saver. Press the ESC key to stop 
the Animation Painter or click the Animation Painter button again to deselect 
it.  

1. Next click you Sub-Title Text Box to apply the Fly In From Top Effect to 

your Sub-Title. After click the Sub-Title box, PowerPoint plays the 

animation for you. 

2. Next click your Slide Show view at the lower part of your screen and 

your animated slide plays for you. But, we want to change our Sub-

Title to come in after our Title and provide a delay. 

3. Press the ESC key on your keyboard to return to edit your slide and the 

Sub-Title.  
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4. Using your Effect Options menu, you should 

change the Sequence to By Paragraph and 

in the Timing Group change the Start to 

After Previous and give a one second delay 

between your paragraphs.  

5. Click your Slide Show button and preview 

your completely animated Title slide 

allowing you to focus on the audience and 

not on PowerPoint to begin your 

presentation.  

 

 

 

Removing or Deleting Animation 
we have learned, Animation is easy to add, but how do you remove or As 

delete an animation effect from an object? In PowerPoint 2007, the 
Remove button is obvious on your Custom Animation Pane but in 
PowerPoint 2010/2013 you will need to use the Animation Pane and the 
Drop Down shortcut menu displayed here for the Object you wish to 
remove the animation. As we learned earlier, thankfully, this shortcut 
menu and the effect options dialogue box are similar in the various 
versions of PowerPoint. This is how you may Remove Animation for your 
items.  
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Another type of animation that you will want to use in your slide show is slide transition.  Slide 
transition is how each slide moves from one to another slide in the Slide Show View.  
Animation is movement within a slide, and transition is movement between slides.  You may 
apply Slide Transition using your Transition to this Slide Group.   

Here are the steps to add your transition in PowerPoint 2007. 

1. Click the Animations Tab. 

2. Select a Transition Effect from your gallery.  If you click the More 

button – circled above - the extensive menu 

here appears.  As you hover over an effect, 

PowerPoint previews it for you in the 

background. When you click the effect, 

PowerPoint adds the transition to this slide 

only.  The very last item in the drop down list 

is Random Transition – be careful of Random 

Transition –it may surprise you with a type of 

effect you are not expecting in the middle of 

your presentation.   

3. Modify your speed if you like.  

4. Click Apply to All.  This is easy to forget.   

Apply to all will affect all of your slides and ensure 

transition throughout.  Don’t use sound, unless you want 

to be a comedian – especially for a long presentations – 

PowerPoint will annoy and distract your audience by the 

transition movements and sounds. 

5. At the Advance slide section - Choose On mouse click, 

unless you want your slide to automatically progress 

through the presentation, usually reserved for stand-alone 

or kiosks presentations in which PowerPoint becomes a 

self-running show without a speaker or presenter.   
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6. Place your presentation in Slide Show and preview your entire slide 

show and the transitions from one slide to another. 

 Hot Tip! Like Animation, do not go overboard with various transitions and 

be careful of the type of transition. While there are a few industries and 

people that may appreciate very exciting transitions and use a variety of 

transitions, the general business and professional worlds believe less is best 

with some of the overpowering transitions. I encourage you to be consistent 

using only one transition for your show and  don’t use some of the Exciting 

transitions, particularly in PowerPoint 2010/2013.  

 

Transit ion Tab 
Let’s add transition to our presentation. 

1. Click the Transition Tab which is new for PowerPoint 2010/2013.  In 

the Transition to This Slide section scroll through the Gallery and 

Preview the different types of transitions you may have. There are 

many new selections and Options for the Effects in 2010/2013.   

2. Choose a transition and click the Apply to All button and perhaps 

change your speed.  For humor, you may give a transition sound; 

however, I would avoid having a sound transition on every slide. 

3. Click your preview icon to see your transition or click the Slide Show 

View button to see your presentation in slide show and click to 

advance through your presentation. As with Animations, you may use 

the Effect Options menu to change direction and other items based on 

the effect you choose. 

4. PowerPoint 2013 provides more Transitions 

and effects. I am using the new Airplane 

transition and changing the direction in the 

Effect Options.   
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If you have an existing presentation that you wish to keep intact, yet want to 
use some of the slides or all of the slides in another presentation, PowerPoint 
provides a great and easy way to import or reuse your slides and view them 
before you bring them into your new presentation.  I really like this feature – I 
have standard slides I use in all of my presentation and this allows me to 
retrieve the information without importing the formatting.  I receive 
presentations from other sources and may want to use only 1 or 2 of their 
slides; this section explains how to accomplish this task.  Also, if I have 
permission, I will use slides that other people have sent me using this feature. 

1. Create a new presentation or use an existing 

presentation. 

2. On the Home Tab, Click the New Slide button and from 

the menu and at the bottom click the Reuse Slides item. 

3. The Reuse Slides Task Pane opens, 

4.  Click Browse. 

5. Using the browser, locate where you store your 

presentations and select a file or use a file from the 

materials provided with this book. – usually My Documents on the C 

Drive.  Once we find our file 

6. Click Open. 

7. The Task Pane changes to views of your slides.  

8. When you click a slide, PowerPoint inserts it into your 

presentation at the slide you were working on. 

Also, notice that you are able to keep the original formatting and background by 
checking the Keep source formatting.  I want these slides to use the same fonts and 
color scheme as the other slides in this presentation so I do not click the Keep source 
formatting check box.  

PowerPoint changes the color schemes and updates the Imported slides to our 
design template!  The information or data does not change; however, the bullets, the 
colors, the fonts, and other formatting are reflecting in our new presentation. 

Save your Presentation. 
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Also, if you have an existing slide and want to change the 

layout, you may use the Layout menu on your Home Tab. I am 

taking a Title and Content slide and changing the layout to Two 

Content. 

 

A Whole Lot  Going on Here  
Let’s create our third slide with the familiar Title and Text items and add 
a photo through Clip Art (or in 2013 Online Pictures to it.   

 

First, have your Presentation 1 file open and at the second 

slide, click the New Slide button on the Home Tab and 

from the menu choose and click Two Content. 

PowerPoint creates a slide with a title and two content 

areas for you. 

 

First The Title 
As we have previously accomplished add your Title. I have 

entered Title, Text, and Clip Art (How original, huh?!)  A 

picture of this is on the next page. 

 

Second the Text 
1. Click and add bullet items as we accomplished on 

our second slide, please review that slide if you 

need a refresher on entering a bullet list.  My bullet 

list displays at right. 

2. With this bullet list, I had too much white space at 

the end of my bullet list.  You can space your 

paragraphs further apart or bring them closer 

together (if you need more bullets and less space 

between them) by clicking the Line Spacing 
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command button on the Home Tab and the Paragraph group.  

3. Notice I have the solid line surrounding my text box or bullet list by 

clicking on the border, now when I make a change including the line 

spacing all of the paragraphs and text are effected. 
 

 A Hot Tip: To change the line spacing of only one paragraph, simply click in 
that paragraph and make your changes.  You can click and drag also select 
any or all paragraphs to format and use Line Spacing.  The Line Spacing 
Options provides further customization for your line spacing and paragraph 
formatting. With the solid line border around your Text Box as I am doing the 
Line Spacing affects all of the text so no need to click and drag to select the 
bullets and lines.  

Third the Clip Art 
Art Work with Clip Art and Online Pictures 

1. At the box on the right of your Slide click the Clip Art button in the 

content box. 

2. The Clip Art task pane activates and  I 

have typed education and then clicked Go 

to select my clip art Search for box.  

Locate the Clip Art you like and click the 

arrow next to your Clip Art and from the 

menu click Insert. 

3. The Clip Art inserts in the appropriate 

place on your slide.  You may need to 

resize your Clip Art by placing your cursor 

on a circle and with the double headed 

arrow displaying click and drag in or out 

to make your Clip Art larger or smaller.   I 

like using the corner circles to change the height and the width at the 

same time.  This works the exact same as with text boxes, pictures, 

and other PowerPoint objects and items. Clip Art contains all sorts of 

pictures, music, sounds, and animated clip art that we will use in our 

course. 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 
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PowerPoint 2013 Online Pictures 
With PowerPoint 2013, Clip Art and other media elements that use Clip Art changes. Clip Art 
is now Online Pictures, the button displays at right, which activates the Insert Pictures pane, 

also displayed here. With the advent of the Internet and Social 
Media, PowerPoint changes for you to choose pictures from other 
sources.   

 

 

 

 

 

 

 

 

Time to Animate the Sl ide  
Again we will use PowePoint 2007 first 

1. Click in your Title Area of your Third Slide and Click the 

Animations Tab and then Click the Custom Animation 

button to activate the Custom Animation Task Pane. 

2. From the Custom Animation Task Pane click the Add Effect 

button and from the cascading menu choose Entrance and 

from the cascading menu choose more Effects.  

3. From the Entrance Effects menu, I choose Grow & Turn from 

the Moderate section. 

4. Click OK after selecting your effect. 

5. Change your Animation for Grow & 

Turn to  Start With Previous and 

change the Speed if you like as 

displyed at right. 

6. Click your Play or Slide Show button 

to view your animated title. 
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Next, let’s animate the bullet list. 
 

1. Click in the Bullet text area on the left 

part of your screen, 

2. Click the Add  Effect Button and from 

the List or menu choose Fly In. 

3. Modify your Fly In Animation as follows: 

4. Start After Previous, 

5. Direction From Left, 

6. Speed: Fast 

7. These are displayed at 

right. 

8. Next, clcik the arrow by 

the Content Placeholder 

and click the Effect 

Options item. 

9. At the Fly In dialogue 

box, choose a sound if 

you like, 

10. Change the color after animation, 

11. And Animate text by Word. 

12. Click the Timing Tab and Change the Delay to 3 seconds. 

13. Click OK. 

14. Play or Preview your slide and the animation. 

15. Notice that PowerPoint waits 3 seconds 

between your buttets. 

16. The sound did not work for me so I went back and removed the 

sound as it did not work well with animated the text by word. 
 

 

Now, I’ll show you how to animate the Clip Art here and we’ll make it 

Automatic after our Bullet Text completes. 

1. With your Clip Art selected, activate the Custom Animation Task Pane. 

2. Click the Add Effect Icon. 

3. Trace to Entrance. 

4. Choose an Animation from the Entrance cascading menu or click More 

Effects. 
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5. I clicked on More Effects and chose Spiral In. 

6. Pictured at right are my settings for the Clip Art.  I 

have this Starting after the Bullet list with the After 

Previous selected.  My speed (at least for the Clip Art) 

is Medium.   

Click the Slide Show icon and ensure your title, text, 

and clip art animate correctly.  This entire slide is 

animated and all you have to do is stand there and 

look pretty and let PowerPoint do all the work! 

 

 

Animation Order  and Re-Ordering 
If your animation is not in the appropriate order, you can change the order of your 
animation by selecting the animation you wish change and click the up or down arrow 
in the Re-Order section at the bottom of the Custom Animation Task Pane as picture 
here. The Animation Pane in 2007 and 2010 contains the Re-Order section. 
PowerPoint 2010/2013 has the Reorder Animation item in 
the Timing Group of the Animation Tab.  

I have moved my Picture 4 or Clip Art to come in before my 
bullet list on Slide Three.   If your item is at the top of the 
order the up arrow will gray out since you can go no further 
up.  If your item is at the end of the order, the down arrow will gray out since you can 

go no further.  

As you work with the Animation Pane, you will notice that for your 
bullets and other items you have arrows that can expand  your Content 
Placholder. The Content Placeholder contains all of your bullets, text, 
etc, so when you add or change animation it affects all of your items at 
once.  

If you click the exapansion arrows, PowerPoint lists your bullets and 
items for you. After clicking the expansion arrows, I move my Picture 4 to 
between my second and third bullet. Finally, I click the arrows again to 
hide or collapse my Content Placeholder items. The Picture 4 is now 
contained in the Content Placeholder.  

 Hot Tip! Be careful of using the Content Placeholder in an 
expanded view because you may rearrange and move items 
incorrectly, so you should collapse/hide your expanded 
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contents pane after working on the individual elements. Using the expanded 
view, you may give individual bullets different animations, which you should 
avoid. Remember, you should be consistent in your animation and 
transitions.   

PowerPoint’s Design Tab  allows you to easily and quickly move from one type of design to 
another.  Let’s first change your Design using the Slide Design Tab.   

 Cautionary Note:  While PowerPoint’s Design themes are beautiful and professional, many 
of us have seen these schemes ad nausea.  Use PowerPoint’s design to get ideas and to use in 
case of emergencies.  You should design your own PowerPoint theme and use it to produce 
custom designs and to help you in branding your products, services, or other educational 
elements.  Your marketing efforts and company/brand recognition will increase dramatically by 
incorporating your own pictures, logos, and other design elements.  For example, three 
presentations I viewed within days used the same design template; I can’t remember much 
about their presentations and since they used the same scheme – their message ran together.  
While presenters that used their own design and unique themes, captured my attention more 
and I remembered the information; their presentations were more distinguishable.  We will 
learn how to create our own backgrounds, logos, design schemes, and color scheme later in the 
course.  We will use PowerPoint’s for now and create our own, custom design theme and 
template later.  

Pictured at right is the Themes for my 
Design Tab in 2007/2010.  You can scroll 
through your designs and choose your own 
and you can also download other design 
templates from the Microsoft Office website 
or other websites.  There are some fantastic 
designs and color schemes. 

Themes 
1. In your Presentation 1 file, 

Click the Design Tab, Scroll 

through the Themes/designs 

and select one. 

2. Using the Drop Down arrow 

next to your slide thumbnail 

choose Apply to All Slides. 

3. All of your slides update with the new scheme. 
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4. Repeat this process selecting a different Design Template. 

 

Color  Design 
1. Now, let’s change our color scheme –  Be careful not to 

choose a color that is close to or the same as your 

background colors – you won’t be able to see your text or 

other items.    Click the Colors button on the Themes 

Group in the Design Tab, Scroll through and Select a new 

color scheme. 

2. At the bottom of the Color Schemes Task Pane you will see 

Create New Theme Colors. . . Click this link.  

3. The Create New Theme Colors dialogue and menu opens 

for you to select new colors for your elements using the 

arrows and palettes. Select the item whose color you wish 

to change and then Click the Change Color button. 

4. The color palette activates and you may select your new 

color using the Custom and Standard Tabs in the Color 

Palettes.  Again, keep in mind other colors of your slides 

particularly the background color. You may be 

very specific about your color using the RGB or 

HSL Color mode as displayed below 

5. Name and Save your New Color Scheme. Your 

new scheme will appear at the top of the Colors 

menu above the Built-In schemes. 

6. Your presentation reflects your new color scheme. 
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Font Themes  
As with color, you should create your own theme fonts and incorporate your 
organization’s preferred fonts. You may choose theme fonts from the Design 
Tab and the Font button and menu. From the Font menu, you may click Create 
New Theme Fonts to activate the pane for you to choose a Heading font and a 
Body Font. You should name your font theme and click Save.  

 

Remember no more than three fonts per presentation, so don’t go font crazy in 
PowerPoint. 

 

 

 

 

 

 

 

 

 

 

PowerPoint 2013 – Design Notes 
PowerPoint 2013 contains the Variants Group in the Design tab for 
you to change your color and font themes and other items. Clicking 
the More arrow circled at right displays your Colors, Fonts, Effects, 
and Background Style items. Hovering over these items activates 

the menu for your color schemes, font themes, etc. 
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Very Smart ,  I t ’s  a  Chart!  
One of the best and most fantastic features of PowerPoint is its ability 
to display graphical objects such as charts and diagrams which we will 
learn as we create the next several slides.  While I usually use Excel to 
create my charts, I always use PowerPoint to display the chart by 
copying the chart from Excel and pasting it in PowerPoint or linking the 
chart between the two applications.  PowerPoint can bring in each 
section or part of a chart through Animation.  This makes even the 
most complex and difficult to understand chart palatable to Liberal 
Arts Majors, like me.  PowerPoint allows me to speak on each item and 
have the audience concentrate on one piece of a Pie Chart or one 
column of a Column Chart without having to try to absorb and 
understand the entire chart at once. We will create a column chart 
here and look at other charts and we will Copy/Paste and look at 
linking an Excel chart to PowerPoint later. 

 

Creating a Chart  
Here are the steps for creating a Column 
Chart in PowerPoint. 

1. Click the New Slide Icon and 

using the Menu Click the 

Title and Content slide from 

the gallery.  

2. Click in the Title Area of the 

slide and add a Title for your 

Slide chart – I am entering: 

Our Sales Results.  

3. Click the Insert Chart button 

on your content pane as 

displayed at right. 
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1. The Insert Chart gallery opens with many types 

of charts and schemes to use. 

2. I am choosing the 3-D Clustered Column Chart 

from the gallery.  Click the chart you wish and 

Click OK. 

3. Excel Opens side-by-side with PowerPoint and 

contains Column 

and Row Headers 

for you to type 

over. I am 

entering the 

regions as columns 

and the products 

as Rows as 

displayed here and 

entering numbers 

in each cell.  My 

numbers are in 

millions of dollars 

and are 

represented by 2 digits.  

4. Notice the note to drag the lower right corner to increase your range of 

columns and rows.  I accomplished 

this for my fourth Item – Outlook.   

5. Enter your information as you like in 

Excel and PowerPoint updates your 

chart.  My information displays at 

right. After entering your 

information, you may close Excel or Click away from your chart in 

PowerPoint to close Excel and view your Chart in PowerPoint. 

6. Save your work, Click the Save Icon.  

 

PowerPoint allows you to customize and change your chart in many ways.  When you click your 
chart on this slide, PowerPoint displays three new tabs under your Chart Tools  at the top of 
your Ribbon – Design, Layout, and Format.  We will use these tabs to edit and enhance your 
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chart and then we will animate our chart. 
 

Chart  Design Tab   

You can change the Chart type by selecting Change Chart Type on the Chart Tools – Design 
Tab, and gallery of charts appear for you to choose a new one.  Depending upon the type of 
chart you are using such as a Pie Chart changing to another type of chart such as Bubble or Bar 
chart may not work or not be as useful for you.  You should know your data and the type of 
chart that you would like to work with before beginning the chart creation. 

You can select different areas of your chart by clicking an area and use your Layout and 
Formatting Tabs to change the attributes, such as color or font size. 

We will use these tabs and change our Chart type in the upcoming sessions. 

Let’s change our Style. 

1. Click in your Chart on Slide Four and from your 

Design Tab Scroll through your Chart Styles and 

click them to see how the colors and other items 

affect your chart.   

2. You can click on the More arrow as displayed and 

circled at right and the entire gallery of designs and 

styles will appear from which you may choose one. 

3. Choose a style your want for your Chart. 

4. Next in the Chart Layouts group, click several types 

of layouts and change your layout.  I am using one 

that provides a Chart Title.  The Chart Layouts have 

a More button for you, too. 

 

From here you may edit your data in Excel using the Edit 

Data button, which opens your information in Excel for editing. 
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Chart  Layout  Tab  

 

The Chart Layout Tab allows you to format, edit, and add many elements to your chart.  From 
the Layout Tab you can insert Titles for your Chart, Axis, Categories, and edit your Data Labels 
and Legend.  As displayed above I am adding Major Gridlines to my Primary Vertical Gridlines 
on my chart. We’ll use many of these items but you should explore all of them on your charts.   
The Current Selection Group is on the Layout and Format Tabs for Chart Tools and is the first 
group on these two tabs.  The Current Selection Group and its command buttons allow you to 
change and format any component in your chart.  You can select the chart object using the 
Drop Down menu or click the area of your chart you wish to format and the name of the area 
will appear in your name box.  My Vertical (Value) Axis is selected and pictured at right. 

1. On Slide Four, Click in your Chart to activate the Chart Tools Tabs and 

Click the Layout Tab. 

2. Using the Current Selection Box or click the Numbers 

on the left of your chart to select the Vertical Value 

Axis. 

3. Click the Format Selection button on your tab or right 

click on your numbers and from the short cut menu 

choose Format Axis, notice the Mini Toolbar for 

formatting, too.   
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4. From the Format Axis Menu choose Number 

and change your number to Currency with no 

decimal places and click OK. 

5. Your Numbers change to currency with no 

decimals.  Make other changes using your 

Layout tab and formatting. 

 

 

6. Next, I am changing my Walls and the color of 

my walls (Background of my Chart). This menu 

displays at right. 

 

Use the other command buttons and decide you want to use 

them for your charts, such as showing or not showing the 

data table, adding titles and gridlines to your chart. 

 

 

 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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Chart  Format  Tab 
 

Like the Layout Tab, the Chart Format Tab allows you to customize elements of your chart with 
different styles, colors, and other formatting options. You can use the Command Buttons on the 
Format Tab or you can use the Format Options for the 
selected items as we previously accomplished for our Value 
Axis and Walls. 

1. You may click on an object or chart 

element to select it or use your Current 

Selection and the Name box to select the 

object or element in which to work.  My 

South Series displays in my Name box 

above and I am using my Format Tab and 

Shape Fill menu to change the Color of the 

South to Red. 

2. Using the Design Tab, Change your Chart 

Title Style using WordArt Styles, 

3. Change one of your columns to another 

color.  

4. Use your Format Selection for the South Series in your Current 

Selection group and from the Format Data Series change the column to 

a pyramid using the Shape item. You may 

right click on a chart element and from the 

shortcut menu click Format at the end of 

the menu; here I right clicked on a column 

and from my shortcut menu chose Format 

Data Series. 

 

Go ahead and practice and make other changes to 

your chart using the Design, Layout, and Format 

tabs for Chart tools.  
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Chart  Animation  
Just as with other elements of your presentation particularly bullet items, as we have discussed, 
animating your chart will have impact on your audience and allow them to concentrate on one 
element or series/category at a time.  As I related earlier, I encourage you to animate your 
series and individual chart items so you may display each item as you discuss 
it.  This is effective and will not overwhelm your audience with a “busy” chart. 

 

Chart Animation – PowerPoint 2007 
Let’s Animate the Title and the Chart of this slide using PowerPoint 2007 then PowerPoint 
2010/2013.  Here’s how 

 

1. Activate your Custom Animation Task Pane.  

2. Animate your Title to enter automatically With Previous and 

choose your animation and other elements using the previous 

lessons as a guide to animate your title. My Custom 

Animation pane and the modifications for my Boomerang 

effect display at right. 

3. You animate a chart and its contents just as you do other 

slide elements. 

4. Add an effect first for an entrance and then using the Effect Options to 

customize your animated Chart. 

 Please note that not all effects will be available for your chart; some animations are 
designed only for text. For charts, I use basic entrances such as fly in, dissolve, appear, and 
wipe effects that allow each chart item to appear independent of the other and will not 
overwhelm the chart elements. While I like animating my chart elements and doing so makes 
presenting easier, I don’t want to overdo it with unnecessary and distracting animations. 

1. Click in your chart. 

2. From your Custom Animation Task Pane, Click the 

Add Effect button and from the menu Click Entrance 

and from the cascading menu choose an effect (I am 

choosing Wipe) or Click More Effects and choose your 

animation effect. 
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3. I changed my speed using the Modify section of my 

Custom Animation Pane. 

4. Next click on the Arrow for your Chart and Choose Effect 

Options. 

5. Your Effect Options dialogue box has a new tab called 

Chart Animation.  

6. Click the Chart Animation Tab. 

7. I have my Animate Grid and Legend Item checked. 

8. The Group Chart: item is very important. This is the 

setting that allows your chart to be completely 

animated.  If you do not see By Series, By Category, etc 

in your list your Effect cannot perform the animation 

except As one object (BOO! HISS!).  You’ll have to 

choose another animation effect to animate your 

chart completely. 

9. I have chosen By series – I like all of them except 

as one object. 

Try these different items, such as By Element in 

Series or in Category to decide if you like this or not. 

I have kept my effect on Mouse Click; however, you can animate 
each part of your chart to play automatically using the Timing Tab if 
you like.  This is no different than animating your bullet list to be 
automatic or other objects in PowerPoint.   

1. Click OK after making your Chart Animations and Timing Tab 

selections. 

2. Click the Play icon. 

3. If all is well, click the Slide show icon and watch your chart an its 

animation as you press enter or click your mouse button. 

Isn’t this much better than seeing the entire chart appear?  As a presenter you’ll appreciate the 
ability to explain each element of your chart in a concise manner and the audience will 
appreciate the animation and ability to concentrate on each item.  This really helps deliver your 
message and makes complicated charts and graphs much easier to understand. 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 
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Chart Animation – PowerPoint 2010/2013 
1. Click on your chart to select it and using your Animation tab choose 

your Animation. 

2. After selecting your Animation, click the Effect Options button. From 

the menu review your choices and decide how you want your chart 

components to enter. I have mine by Series. 

3. Finally, I slow the animation by changing my duration to two seconds 

and since I want to control when the element appears, I have kept my 

Start to On Click. 

4. On your Animation Pane click the Play button or click your Slide Show 

button to review your animated chart. 
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Diagrams, Organization Charts, and other specialty charts are good, graphical tools that 
display items that are more text based than numbers based and are not as complex as a flow 
chart.  They assist in reducing your need to draw items to make a chart or graphical picture of a 
process.  SmartArt is an excellent means of conveying a process, a goal, simple charts, and 
organization charts.  SmartArt encompass the organization chart, now and many other types of 
objects, such as pyramids, Venn, and other neat graphical displays.  We’ll create a Cycle or 
process diagram for Slide Five.  

Creating a Diagram  
Let’s use PowerPoint to create a  Diagram.  This feature is 
available on all Office applications and activates by using the 
Insert Tab and the Illustrations Group or from creating a New 
Slide and choosing Title and Content – the Content group 
includes SmartArt Graphics  and displays at right.  This will 
activate the SmartArt Gallery and other steps to achieve an 
attractive display.  The SmartArt Gallery may activate through 
the Insert Tab and the SmartArt command button on the Illustrations Group. 

1. Open the Presentation 1.pptx file. 

2. Move to the last slide using your Vertical Scroll bar 

or your Slide view on the left section of your screen 

– this should be Slide 4. 

3. Click the New Slide button on the Home Tab and 

from the menu Choose Title and Content as your 

slide.  

4. Add a Title – I have typed:  Our Sales Cycle. 

5. Click the Insert SmartArt Graphic item in the Center of your Slide. 

PowerPoint activates the SmartArt 

Graphic gallery with many 

diagrams, charts, and graphs to 

select.  Scroll through and notice 

all of the neat ways of displaying 

your information PowerPoint 

offers. 

6. I will use the Basic Cycle for my 

SmartArt Graphic. Choose your 

diagram and click OK. 
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1. An outline of your diagram appears on the Slide. 

2. The  SmartArt Tools tabs appear for you when you are working on your 

graphic.  SmartArt Tools 

include the Design and Format 

tabs which we will use to 

change our diagram and 

customize the Cycle. The 

SmartArt tools allow you to 

Change your layout, Change 

the type of Diagram and other 

items.   

3. Next – Click in each text box 

and type your process or other 

words describing your items or 

you may use your Text Pane. 

The arrows circled in red at 

right activate your Text Pane 

or closes it. After typing in each text box or using your Text Pane, Click 

outside of the Diagram area to view your diagram in the slide. My Sales 

Cycle and the text appear above. 
 

After you enter your information in the Graphic, PowerPoint allows you to customize and 
change your items using the Design and Format Tabs.  We will begin 
with the Design Tab and its important features and then use the Format 
tab to customize our colors and text. 
 

1. Click in your Diagram and from the Design Tab click 

the Change Colors button.  From the gallery choose a 

color scheme you desire.  Your colors are based on 

your design theme and mine is boring.  I will change 

my colors and other effects using the Format tab 

later. 

2. After choosing a color, next choose a style using the 

SmartArt Styles gallery. Click each one and then 

choose a style of your liking.   

3. Click your Slide Show icon to display your beautiful Diagram Slide. 
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SmartArt  Design Tab  
The SmartArt Design tab  contains the following Command buttons and Groups: 

Add Shape will add another shape, such as another level in your pyramid, to your diagram. 

Add Bullet – This allows you to create bullets within a graphic box.  This is terrific if your 
diagram’s boxes, arrows, and other object is large enough to contain bullets. 

Right to Left  – Will change the direction of your diagram and will be different depending upon 
your diagram.  This can also change the order of your items.  
Layout Command Button and the Layouts Group – Using this item can change the size 
and position of your Hierarchy or other type of chart.  The Layouts group offers a gallery of 
different layouts for your selected SmartArt. 

Promote and Demote –  Allow you to change your bullet, text, 
and other object levels. 

Text Pane activates a window for you to edit and enter your text 
and add objects to your SmartArt.  My Text Pane dispalys at right and 
I am entering a new object and text at once by pressing enter after 
the Choke the Client! Text.  PowerPoint creates another bullet for me 
to type and another object in my diagram. 

 

We have used the Changed Colors and SmartArt Styles already. 

Reset Graphic restores the SmartArt to its original and default 
look. 

 You may right click on a section of your diagram and  receive 
a short cut menu.  I have right clicked on my Meet and Greet 
the Client box and receive the menu at right. I like Adding 
shapes from this Short Cut menu. I use the Mini Toolbar for 
formatting and the short cut menu for other types of formats 
such as Changing Shape. We will use the short cut menu and 
the Mini Toolbar in our next section.  
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SmartArt  Format Tab and Shortcut  Menus  

Once you have your “basic” SmartArt accomplished you can format and customize your colors, 
fonts, effects, and other items for your diagram.  I’ll change my font, the font color, the font 
size, the color of my shapes, and other formatting items in the next section.   

 A Hot Tip! You may use the Shift + Click or the CTRL + Click method to 
select more than one item in which to work.  I press the Shift key and keep it 
pressed, then I click the objects that I want to change at once rather than 
change each object one at a time.   

1. Click on your diagram in Slide Five to 

activate the SmartArt Tools and 

particularly the Format Tab. 

2. Next, press your Shift key and keep it 

pressed as you click each of your objects (I 

have chosen the box layout).  PowerPoint 

places small circles around your selected 

objects. 

3. Next, Right click on one of the selected 

boxes and from the short cut menu, Click 

the Font. . . item. 

4. PowerPoint activates the Font dialogue 

box for formatting. Change you font, 

your font style, effects, and size from 

this box.  My selections are displayed at 

right. 

5. After making your font selections, Click 

OK. 

All of your text boxes up date. Now, let’s 

change the fill color. 

Click away from your graphic area to clear 

your selections. 
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 A Hot Tip!  A Reminder - When you click to select an object, PowerPoint 
places a solid line around your object and when you right click on it you will 
receive a short cut menu.  When you click IN the object, PowerPoint Places a 
dotted line and solid line around your object for you to select the text for 
formatting and when you right click in an object PowerPoint provides the 
short cut menu AND Mini Toolbar for formatting.  This saves time when 
changing shapes, choosing another fill color, and other formatting tasks.  I 
display and use these in the exercises below.  
 

1. Click the first box (or other object depending upon 

your diagram) to select it. 

2. Next click in the box as displayed at right and then 

right click and from the Mini Toolbar change your 

fill color. Notice the other type of fill effects 

available.  

3. Make other formatting changes that you wish to 

each of your objects. 

So many ways, so many choices! 
PowerPoint offers so many ways to 
accomplish formatting. We have used the 
Short Cut menu and Mini Toolbar to change 
our fill color and other formatting changes. 
You may also use the Format Tab – as 
displayed at right I am changing my second 
box’s fill color using the Shape Fill button on 
the Format Tab. 
In the far right picture, I am changing my fill 
color using the Home Tab’s Drawing Group 
and the Shape Fill command button. 
 
 

Now, you should play around with your own effects and 

choices.  As displayed here, I am using the Format Tab and 

Styles Group and the Shape Effects button to change ALL of 

my objects at once and below I am using the short cut menu 

to change a Shape. 
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My completed Slide Five displays below. 
 

 A Hot Tip! Nudge! Moving and Resizing objects 
using your arrow keys – I moved and resized some 
of my boxes for the text to fit.  You may select a box 
and using the corner circles click and drag to change 
the height and width at once OR you may press the 
Shift key and with the shift key press use your arrow 
keys to change the size of your object.  Also, the 
green circle rotates your object. With the object 
selected you may use your arrow keys to move the 

object.  AND if you press the CTRL key and keep 
it pressed as you use your arrow keys 
PowerPoint will “nudge” your object.  Nudging 
is moving in very small increments.  This is very 
helpful and sometimes easier to use than your 
mouse . Practice both of these – I think you’ll 
like using them. 
 
 
 
 
 
 

SmartArt  Conversion  
A very nice feature in PowerPoint is to take an 
existing bullet list or other list and convert it to 
SmartArt. All versions (2007 – 2013) have this 
feature on the Home Tab. I have PowerPoint 
2013 Convert to SmartArt button and menu 
displaying here.  In PowerPoint 2010 and 2013 
you may convert your SmartArt back to Text or 
the Shapes. The Convert SmartArt to Text or 
Shapes button is on the Design Tab of your 
SmartArt tools.  
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SmartArt  -  Diagram Animation  
Animating your diagrams is no different than animating your Charts.  We will 
review this process and animate the diagram to display automatically. 

SmartArt Animation in PowerPoint 2007 
1. Be on Slide Five of your Presentation 1.pptx file. 

2. Activate your Custom Animation Task Pane. 

3. Animate your Title to enter automatically With Previous and 

choose your animation and other elements using the 

previous lessons as a guide to animate your title. 

4. You animate a SmartArt and its contents just as you do 

other slide elements. First click inside of your SmartArt. 

5. Add an effect first for an entrance using the picture at right 

as a guide.  I have used Spiral In. 

 Just like charts not all effects will be available for your SmartArt AND not all 
effects will allow you to bring in diagram elements separately.  I use basic 
entrances such as dissolve, appear, and wipe effects that allow each diagram 
item to appear independent of the other.  

1. Next click the arrow next to your Content 

Placeholder and Choose Effect Options. 

2. Your Effect Options dialogue box has a new tab 

called SmartArt Animation.   

3. The Group Graphic: item is very important. This is 

the setting that allows your diagram to be 

completely animated.  If you do not see Clockwise 

for Radials, Up or Down for Pyramids, Inward or 

Outward for Targets  or other element, in your list your Effect cannot 

perform the animation except As one object.  You 

must choose another animation effect to animate 

your diagram separately. 

4. I have chosen One by one for my Cycle Diagram. 

5. Click the Timing tab and change your Start to be 

After Previous (This will activate your diagram’s 

animation after your title appears.) 



Greg Creech  Page 58 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

6. Give a Delay of a few seconds – I have a two second delay between my 

title and the diagram’s animation start and the Speed is changed to 

two seconds (Medium).  

7. Once your SmartArt Animation and Timing Tabs are set Click OK. 

8. Click the Play icon or Click your Slide Show button and watch your 

animated SmartArt diagram. 

 

 An Important Gotcha! For some strange and unknown reason you may need to repeat 

the steps for animating your graph with Previous twice and choose your delay, again.  

There seems to be a system glitch with PowerPoint and animating your diagrams.   

 

SmartArt Animation in PowerPoint 2010/2013 
 

1. You animate a SmartArt and its contents just as 

you do other slide elements. First click inside of 

your SmartArt. 

2. Add an effect first for an entrance using the 

picture at right as a guide or choose an effect on 

your Animation group.  I am using PowerPoint 

2013 and Spiral In from More Entrance Effects 

pane. Click OK, if you are using the More 

Entrance Pane. 

3. Next, using the Effect Options pane, I am 

changing my entrance to One by One. 

4. I want my SmartArt completely animated, so I 

have my Start – After Previous and my Delay 1.5 

seconds. You may keep yours on click if you like. 

5. I play my animations using the Play button on the 

Animation Tab or I view my slide and animation 

using the PowerPoint Slide Show button. 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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With the advent of digital photography and the Internet pictures have entered a new and 
exciting age of sharing, marketing, and displaying.  Photography and slide presentations have 
always been terrific partners; now, PowerPoint with the Picture Tools and Format Tab and 
Animation Effects takes your photographs beyond the static, boring methods of displaying 
pictures that the old, fashion slide projector did. 

Important  Photograph Gotchas!  
 Know where you store your pictures on your hard drive, server, social media site, etc. 

 Know the size of your file – A large size file of your photo will increase the file size of 
PowerPoint. 

 Use animation to introduce and or exit the picture. 

 Ensure the picture ties into your message. 

 Be careful using pictures as a background – due to color variations in photographs 
finding a font size and color that can easily be viewed may be difficult, but not 
impossible.  I have seen some really great pictures as backgrounds that did not have a 
lot of different colors or variations of shades.  You may lighten your picture to use as a 
background, too. 

 The Color icon on the picture toolbar will allow you to “color” a photograph as a Washout; 
this is good to lighten and fade a photo to use as a background.  

 You can Insert a Picture from a Scanner or Camera; however, I encourage you to use 
software designed specifically for scanning or inserting pictures from a digital camera 
not PowerPoint to scan or bring a picture into your computer. 

 While the Picture Format Tab and Dialogue Box are good, you may find that you 
would prefer using a full photo editing application rather than PowerPoint’s Format 
for pictures to enhance and modify your photography.  For quick cropping, brightness, 
and resizing, the Picture Format tab is quick and fine to use. 

How to add a  picture .    
The Picture Command Button at right is available on the Insert Tab.  Clicking the button 
will take you to the Insert Picture dialogue box for you to browse and locate the picture 
to insert. 

How to add a picture.   

1. On the Insert Tab, Click the Picture Button. 

2. PowerPoint opens for you to navigate to your pictures or may 
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assume you want to go to Your Pictures folder.  Navigate to where you 

store photos. 

3. Select your photo; I am using Pine Lake Autumn.jpg for my picture and 

Click the Insert Button or double click your photo. 

4. The picture appears ready for you to resize, move, and add edit! 

In class we will insert pictures from the World Wide Web.  If we are not connected to the Web 
or you want to use another picture, there should be picture files provided with the materials 
you can use for these picture exercises.  Here are the steps of copying or saving a picture from 
the web; however, some web sites won’t allow you to copy or save their photos and graphics. 

Here’s how to Copy a picture from the Web 

1. Right Click on a Picture on a Web Site 

2. At the Short cut menu, click copy, 

3. Return to your document and click the Paste Icon or right click where 

you want to place the picture and click Paste from the short cut menu. 

Here’s how to Save a picture from the Web 

1. You can save the picture on your hard drive or other storage device by 

right clicking on the picture on the Web and in the Short Cut menu 

Click Save Picture As  

2. At the next dialogue box choose the drive and/or folder where you 

want to store the picture, 

3. Name the file, 

4. Click Save. 

Photo Gallery  Sl ide  
Let’s create a slide of photos.  If you don’t have photographs to use, I have included several 
pictures JPEG files with this material. 

1. At the end of your slides, click the New Slide Button 

and from the Menu choose Title Only. 

2. Enter a title for your slide, I have typed My Photo 

Gallery 

3. Click the Insert Tab and click the Picture Command 

Button 

4. Browse to where your pictures are stored 

5. Select your photo; I am using Pine Lake Autumn.jpg 

for my picture and Click the Insert Button or double 

click your photo. 
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6. Click the picture on your slide to select it.  The Picture Tools tab should 

appear with a Format Tab.  

7. Insert a second picture into your slide – I am using Lake Sunset.jpg. 

 

Format  Picture Tab  

Microsoft Office, including PowerPoint, has a Picture Contextual Tools Format Tab that 

activates when you click a picture.  Displayed above is the Picture Tools and Format Contextual 

tab from PowerPoint 2010.  When you click or select a picture, this tab activates for you to click 

and make changes to your photo.  We’ll examine some of the important parts of this tab and 

corresponding Command buttons and menus.   

1. With your photograph selected, choose a Picture Style from the Format 

Tab. There are plenty of terrific styles to start you on your formatting 

path. 

2. Next you may add or change your border color, width and other options 

using the Picture Border button and cascading 

menu.  

3. Next using the Picture Effects button and menus 

add some pizzazz to your picture. I am including 

a Glow for photo. Review all of these options for 

shadows, reflections, and so on. 

4. You may remove areas of your photo using the 

Crop tool. Clicking this places cropping marks 

around your photo so you may click and drag 

these markers to designate areas you wish to 

remove. After clicking and dragging your 

markers, click the Crop tool button again to 

remove the areas. 

5. The Adjust Group on your Format Tab is important for you. You should 

review the Corrections and Color options available for your photo. 
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6. After resizing and/or cropping your photos you 

should always click the Compress picture 

button. When you resize or crop a photo, the 

viewing size of the photo changes for you but 

not the amount of file space that the photo 

uses. For example, if you insert a photo that is 

five megabytes, your PowerPoint presentation 

file size increase by five megabytes. After 

formatting your photo and changing its viewing 

size, the Compress Pictures menu allows you to 

delete cropped areas and reduce the file size of 

your PowerPoint presentation.  I am using a Screen resolution 

displayed here.  

7. Another nice button is the Change Picture. This button allows you to 

change the photo without losing any of your formatting.  
 

Artistic Effects on Photos 

Office 2010 and 2013 add Artistic Effects to the 

options available to enhance and alter 

photographs.  I have a photo selected at right and 

with my Artistic Effects pane active I can view the 

various effects on through Live Preview to 

determine which effect I may want to use. Some of 

these are really great and some distort the photo 

so much I can’t tell what the photo is.  

 

 

 

Enhancing the Picture 
You can use the Text box Button on your Home Tab and the Drawing group to create a text 
box or caption for your picture. Once your Text box is in your Picture, you can type your 
heading, title, or caption and then format your text. 
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Let’s add a caption to a photo and format the text. 

1. On your photo gallery slide, select a photo (I am using the Pine Lake 

Autumn.jpg photo). 

2. Click your Home Tab and in the Drawing Group click the Text 

Box button. 

3. Click and drag a rectangle at the bottom of your photo. 

4. After drawing your text box, PowerPoint is ready for you to 

type a caption for your photo. I have typed A Lovely Autumn 

Lake as my caption. 

5. Next, format your text with a different font, color, size, and other 

formatting techniques you have learned. 

6. In order to see the caption you may need to move the text box and 

align your text to the right as I have accomplished and displayed at 

right. 

7. Now, we want these photo and text box joined into one object using 

the Group button 

and menu. 

8. Click the Photo and 

then press your shift 

button and click the 

text box or caption 

as displayed at right.  

We need to select 

both of these so 

PowerPoint will 

know what we want 

to group or join. 

9. Click the Group 

Button on the Format tab of your Picture tools.  

10. From the menu choose Group.  Notice that you can ungroup and 

regroup pictures and objects.  You will need to accomplish this in order 

to work with photo and text box independently for moving and 

formatting.   

11. After Grouping your picture, move and resize your photo and 

notice how the text box or caption moves with your picture. 
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12. Insert other photos and format them using your Picture Tools 

and Format tab. 

13. Save your presentation. 

 

 Hot Tip! You can create interesting captions and graphics with your Photos 

using the AutoShapes options on your Home Tab and Insert Tab, including 

stars and other objects. For many captions and text boxes in pictures, you 

may need to change your Fill to No Fill and your Border to No Borders to the 

caption/text box appears to be part of the photograph.  

Enjoy being in the Pictures and PowerPoint! 

Screenshots and Screen Clipping  
With files and programs open, you may use the Insert 

tab and screen shot. I like using Screen Clipping because 

whichever file you were previously working you may 

click Screen Clipping and the previous file opens and 

dims for you to click and drag the area that you wish 

to insert your Screenshot.  If you simply click the item 

in the Available Window menu, the entire screen inserts 

into your file.  After the insertion then you will need 

to perform any formatting, such as cropping and 

resizing.  

As an example, I open an Excel workbook with a 

listing of clients, this file appears first in my list of 

Available Windows.  As displayed above I am choosing Screen Clipping and 

since I was in the Excel worksheet last, Office opens my Excel worksheet 

and dims for me to click and drag to 

select the area I want to insert into the 

document as displayed here.  After I 

click and drag the area and then release 

my mouse button, this area 

automatically inserts into my 

PowerPoint Presentation. 

 Write your notes here: 
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_____________________________________________________________________________________________  
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We have studied using simple sounds in PowerPoint through Animation and we have animated 
pictures in PowerPoint.  Now, we learn how PowerPoint can display videos and more extensive 
sound files.  We will also look at how PowerPoint can automate and animate your tasks during 
a presentation through items called Action Buttons which can act as intelligent hyperlinks to 
run programs, open files, and display web sites.  PowerPoint does a good job in allowing you to 
insert sounds and to play Videos or Movies from files. We will insert an animated GIF file, which 
is an animated Clip Art, and we will insert a video. We will insert Clip Art sounds and look at 
other music and audio options.  

 

PowerPoint can manage and play various types of multi-media files.  These include ausio files in 
the format of wav, midi, mp3, and others.  Audio file types include mpeg, avi, wmv, and others.   

I encourage you to play with your multi-media components of PowerPoint to strengthen and 
enhance your message.   

 

In PowerPoint 2007, we will use more of the Custom Animation features with Multi Media and 
will see how Custom Animation can change based upon your media sound and movie files. 

We studied Custom Animation a lot and now you will see a benefit.  Learning Multi Media after 
knowing the Custom Animation process cuts down tremendously in your learning curve.  
Inserting a Movie or Music is easy; customize when and what the movie or music to play is the 
tricky part and knowing Custom Animation will save you time and frustration in knowing all of 
the options.  

In PowerPoint 2010/2013, we will use the new Video and Audio Tools and the Format and 
Playback tabs.  

Here are the steps we will use to add Multi-Media to our slides and to insert audio or vidoes on 
a specific slide for you to play during a presentation: 

1. On the Insert tab, click the Movie/Video or Sound/Audio button and 

your options appear.  

2. We will use Movie/Video from File and Movie/Video from Clip 

Organizer and we will play a Sound from Clip Organizer and Play music 

from our computer.  

Your movie or video may play automatically or using an icon that will appear for you to click 
and have the video run.  Sounds operate in the same manner.  You insert a sound and you may 
have the music or sound play automatically when the slide is opened or have it play when you 
click a button on your screen.  You may select sounds from a Gallery, from a file on your 
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computer or server, Play a specific CD Audio Track in PowerPoint 2007 (Just make sure you 
keep your CD in the CD Drive for PowerPoint to Play!), or you can record a sound for 
PowerPoint to play.   

Once you insert a sound or video, you may alter the timing to be automatic, to pause your slide 
show, and other options through the Custom Animation pane we have worked in previously.  
This is very similar to our previous methods of setting animation.  In PowerPoint 2010/2013 we 
will use the new Playback and Format tabs for Audio/Video Tools.  

PowerPoint  2007’s  Sound Options Tab  

 
As with other objects and items in PowerPoint, when you click your sound or CD icon on your 
Slide Show in Normal view, PowerPoint as an Options tab for Sound Tools and is displayed 
above.  We could have used this for some of our changes above, but we needed to make more 
changes using the Custom Animation pane and boxes.  The Sound Options tab is good for 
previewing your sound, changing the volume, and hiding your icon. 
 

PowerPoint  2010/2013  New Playback and 
Format  Tabs  

As I related PowerPoint 2010/2013 have new Contextual Tabs for Audio/Video Tools, the 
Playback and the Format Tabs appear when you select your audio or video file icon.  The 
Playback tab for audio displays above and replaces some of the options that required you to 
use the Animation Pane and the Effect Options box in PowerPoint 2007. The Options Tab for 
multimedia files does not exist in 2010/2013. Thankfully the manner in which you insert audio 
and video files has not changed. 
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Other changes in the new versions of PowerPoint include no longer playing audio from a CD 
(that is so 90s!), ability to play from a web site, such as YouTube, and you can perform basic 
video/audio editing within PowerPoint.  

Insert ing Audio/Video Fi les  
The Insert Tab contains the buttons to insert Movie/Video and Sound/Audio. The 
names change from Movie in 2007 to Audio in 2010/2013 and from Sound in 2007 to 
Video in 2010/2013. Using the Contents Pane on your Slide Layout, you may insert a 
video media clip using the Movie Reel button on the Slide as displayed at right.  

Displayed here are the PowerPoint 
2007 Insert Tab and Media Clips 
group for Movie and Sound at the 
top and the PowerPoint 2010 Insert 
Tab and Media group for Video and 
Audio  (PowerPoint 2013 is similar to 
2010).  

We will work with Inserting from 
these various sources and then 
modify our multimedia file within 
PowerPoint.  

 
 
 
 
Let’s have music play when we open our presentation at the Title Slide and 
then we’ll add other music and movies in other slides. 

 

Music,  Narration,  or  other  Sound from a 
F i le  

If you have music, narration, or other type of sound you wish to play from your 
computer and in a sound/music file format, such as .wav, .mid, .mp3, etc., we’ll 
use that file for our next section. 

Important Gotcha! When you delete or remove multi-media from your 

slide using the Animation Pane, PowerPoint does NOT remove or delete the 

icon for your music or multi-media file.  You’ll need to select the multimedia 

icon on your slide and press delete. Deleting the icon or graphic that 

represents your audio file deletes the audio/sound and the icon/button.  
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PowerPoint 2007 Multimedia process using the Custom Animation Pane for editing. 

1. Click on your first slide the Title Slide.  

2. Click the Insert Tab and then the Sound button and 

from the cascading menu choose Sound from File. 

3. Next, navigate to where your musical or other sound 

file is stored on your computer.  Select your sound file 

and click OK. 

4. At the next screen, click Automatically. 

5. PowerPoint displays the sound icon 

for you as pictured here. 

6. Next activate your Custom 

Animation pane and select your 

sound media at the bottom of your 

list and using your Re-Order button, move 

your sound/media to the top. 

7. Change your Start to With Previous so the music will 

play when the presentation begins. 

8. Next using the Drop Down arrow next to your 

animated media, click Effect Options to open the Play 

Sound dialogue box.  As displayed at right, I am 

changing from where the music starts and the music 

will stop playing after the current slide. 

9. Click the Sound Settings, change your volume if you 

like and since we are playing this automatically hide 

the sound icon. 

10. Click OK. 

11. Preview your Title Slide and Presentation 

opening in Slide Show View. 

12. After the first slide, press the ESC key to 

end the slide show and return you to Normal 

view. Save your file. 
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PowerPoint 2010/2013 Multimedia process using the Playback tab. 

1. Click on your first slide the Title Slide.  

2. Click the Insert Tab and then the Audio button and from 

the cascading menu choose Audio from File. 

3. Next, navigate to where your musical or other audio file 

is stored on your computer.  Select your audio file and 

click the Insert button. 

4. PowerPoint displays the audio icon for you as pictured 

here. Notice you may play your Audio while in the 

Normal view and editing your slide. 

5. Activate your Animation Pane and when you click on 

your Animations Tab you will notice that this changes 

for you to play and pause your Audio too. Your Audio 

File displays in the Animation Pane. 

6. Now, with your Audio File selected on your screen, click the Playback 

tab. Using the Playback tab I have added Fades for my audio and set 

the Start Automatically so when I begin my presentation the music 

plays for me. Since I am having the music play 

automatically, I do not need to have the Audio 

button showing on my screen so I check the Hide 

During Show to make the audio icon invisible. 

7. Next, in the Animation Pane I have moved my 

music file to begin earlier and to be the first item 

animated.  

8. Finally, I click the Play button and review my 

slide’s animation and audio. 

 

A nice, new feature for PowerPoint 2010 and 2013 is the ability to perform basic edits on your 
audio and video files from within the application. 

Let’s edit our audio file and trim it. 
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1. Select your Audio File and from the Playback tab click Trim Audio.  

2. The Trim Audio pane appears for you to click the green beginning 

marker and drag to the right to 

change your start time and then 

click the red ending marker and 

drag to the left to change your 

ending time. As displayed at right, 

I am Starting the music on3 

minute into the song and having it 

play for one minute. 

3. Click Ok. 

4. View your presentation in Slide 

Show to hear and see your 

changes. 

5. Save your presentation. 

 Hot Tip! While the Playback tab in PowerPoint 2010/2013 

offers many features, such as Hiding the icon and trimming the 

multimedia file, you will need to use your Effect Options 

Dialogue box from the Animation Pane to make other changes, 

such as displayed here of ending my music after the third slide. 
  

 

 
C l ip  Art  and Online  Media  

PowerPoint 2007 and 2010 Clip Art Sound  
 

Now, let’s add a musical or other sound from the Clip Art Gallery to our photo slide.  You will 
have many more choices if you are connected online and can use the Office Online Gallery for 
music, sounds, and animated Clip Art.  We will click to play this music or sound. 

1. With your presentation open, go to the Photo Gallery slide. 

2. Click your Insert Tab and the Sound button and from the 

menu click Sound from Clip Organizer. . . PowerPoint 2010 

uses the Audio button and Clip Art Audio. . . item. 

3. PowerPoint activates your Clip Art Task and 

displays all sorts of sounds and music for you – 
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everything from Bach and Vivaldi musical selections to kisses, burps, 

and horror sounds.  Find a sound or music you want and click it to 

insert it into your slide. I am inserting Smooth Jazz. 

4. At the next dialogue box, this time click the When Clicked 

button to start the sound in your show. Skip this step in 

PowerPoint 2010. 

5. Place your presentation is slide show at Slide Seven and 

notice the Sound icon on your screen.  Click it when you are 

ready for the music or sound to play. You could use your 

Sound Options Tab, too, to play your music and change your 

sound levels. 

6. Press the ESC key when you are ready to edit your slide 

show. 

7. Save your work. 

The Clip Art task pane allows you to Search specific locations using the Search in 
box and allows you to change the type of Clip Art you desire.  Since we were 
inserting Clip Art sounds, Clip Art only has Sounds checked in our Results should 
be box. 

 

PowerPoint 2013 Online Audio 
PowerPoint 2013 eliminates Clip Art and uses other sound/audio files from many 
organizations using Bing.com and Office.com.  The Audio button’s menu for 2013 
appears here. After downloading the music and inserting it into your presentation, 
you use the Playback tab and Animation pane as we 
accomplished previously to edit your audio file. 

Pictured at right is the menu that appears when when I 
activate Bing to insert and online audio file. There are 
many sounds, effects, music etc. that you may use from 
these web sites.  

 

Like our Sound/Audio files, Movie/Video files work 
similarly. PowerPoint 2007 uses the Custom Animation pane and Effect Options dialogue box 
for editing and playing the movie/video file. PowerPoint 2010 and 2013 uses the Playback and 
Format tabs. Inserting video files is the same in all current versions of PowerPoint. PowerPoint 
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2010 and 2013 allow you to use web sites for your videos, too. I will use YouTube to 
demonstrate inserting a web video. 

 These are very similar to your Sound/Audio File options and are not difficult to use.  

For the movie in your PowerPoint presentation that accompanies this training course, I have 
used the Movie Settings tab and I checked the Zoom to full screen as you will notice if you view 
my Photo Gallery Slide. 

1. With your Presentation 1.pptx file open, on your Home 

Tab, click the New Slide button and from the cascading 

menu choose Title and Content slide.  You can insert a 

movie as we have accomplished earlier using the Insert 

Tab and Movie Button as displayed at right. 

2. PowerPoint creates our familiar Title and Content slide 

and the Insert Media Clip appears on the bottom row and right button 

displayed here. 

3. Give your slide a title; I am entering Our Newest Associate. 

4. Click the Movie Reel or Insert Media Clip icon. 

5. Navigate to where you store your video files. I am 

using the New Age Secretray.wmv file.  In the Files 

of type section notice all of the media and movie 

formats you may use. Click OK. 

6. In 2007 PowerPoint, Click Automatically at the 

next dialogue box as we have accomplished 

previously. Skip this step for 2010 and 2013 as it 

will not provide this dialogue box.  

7. PowerPoint inserts the movie for you. 

Now we will edit the Video using PowerPoint 2007 first and then PowerPoint 2010/2013. 
Editing and enhancing your video in PowerPoint 2007. 

1. Using your Movie Options Tab, click Preview to view your humorous 

short movie within your 

Normal View. 

2. Also in your Movie Options 

group, check the Hide 

During Show, the Play Full 

Screen, and the Rewind 

Movie After Playing boxes, 
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then click your Preview button. 

3. Next open the Slide in Slide Show and view your movie.  Press the ESC 

key to end your show and return to Normal View. 

4. Click the Custom Animation button and from the Custom Animation 

pane notice you have a couple of items to start your movie 

Automatically.  Click the first item that Starts After 

Previous and from the Drop Down arrow choose Effect 

Options. My movie options display at right. 

5. Click the Movie Settings tab this tab allows you to make 

changes to your movie, too. 

6. Now, Animate your title and save your file. Editing and 

enhancing your video in PowerPoint 2010/2013 

1. With your video selected, use your Playback Tab to click 

Play to view your video within your Normal View. Now using the 

Playback tab, change Start to Automatically, check Play Full Screen and 

check Hide While Not Playing.  

2. View your video in the Slide Show view. Your video should play on its 

own and jump to full screen. After playing your slide is blank.  

3. Press Esc to return to Normal view. 

 

4. Now, I am using a longer video file that I wish to lessen the time. With 

your video selected in 

PowerPoint and your Video 

Tools appearing I have 

clicked the Trim Video button 

that activates my Trim Video 

pane to decrease the time by 

clicking the start marker and 

sliding it in and then clicking 

the end marker and sliding it 
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in to lessen the start and stop times of the video.  I clicked OK.  
 

5. I have set the Fade In and Fade Out to 3:00 seconds.  
 

6. I am keeping my video to Start On Click, so I am not hiding the video 

so I may click it when I’m ready to show the video in the presentation. 

Make adjustments to your video and perhaps change the Start to 

Automatically and click the Play Full Screen item. Finally, view your 

changes in the Slide Show View.  

 

7. Also, new in PowerPoint 2010/2013 is the Format Tab for Video Tools 

which is very 

similar to the 

Format Tab for 

Photos. 

8. With your 

video selected, 

change the 

color scheme I 

am using 

Sepia. Perhaps 

change the 

Shape I am 

using Teardrop 

and choose 

other effects to make your video really tacky!  

9. Play your video and look at your changes in the Slide Show View. Save 

your Presentation. 

 

Video from Web Sites  and Online  Videos –  
PowerPoint  2010/2013  

In this section, I will use my YouTube channel to embed a video into my PowerPoint 
presentation. The Video button the Insert tab has Video from Web sites in PowerPoint 2010 
and Online Videos in PowerPoint 2013. I’ll use PowerPoint 2010 for this exercise. 

 Hot Tip! Depending upon your organizations Internet settings and the 
video copyright, you may not embed, download, or otherwise use Online 



Greg Creech  Page 76 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

Videos in your presentation. I am using my own videos and have the 
copyright to use the video.  

1. Create a Title Only slide and from your Insert Tab click the Video 

button and from the menu choose Video from 

Web Site.  

2. The Insert Video From Web Site dialogue box 

appears for me to paste code from my 

YouTube video. 

3. I navigate to my YouTube channel for the 

video I wish to use in this case Tissue For 

Your Issue. I click the Embed item from Share. Next I select the code in 

the box and copy it. 

4. I return to PowerPoint and paste 

the code in the dialogue box as 

displayed here and click Insert. 

5. When I click my Slide Show button, 

I can click my video from YouTube 

and play it.  

 Hot Tip! Since YouTube or other web 

site controls the video your Playback and 

Format tabs do not work well and many items gray out.  

 

 Write your notes here:_______________________________________ 

 

_____________________________________________________________ 
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Action Buttons are a form of multi-media by allowing you to run other programs, open files, 
play sounds, play movies, navigate within your presentation, and perform other automation for 
you.  While you can use these buttons, you can use any item in PowerPoint to perform an 
action such as words as a hyperlink, pictures, SmartArt, Shapes, or other PowerPoint objects.  
We will create a button and we will create Action Settings for existing objects. 

Here’s how to create an action button. 

1. On the Insert Tab, Click the Shapes 

button and from the menu and at the 

bottom is Action Buttons. I am using 

the Home button. 

2. Click one of the buttons and drag to draw your 

button, just like any other type of shape, after 

drawing your shape and releasing your mouse 

button PowerPoint provides the Action 

Settings dialogue box for you to perform your 

magic. 

 

The Action Buttons allow you to hyperlink to other areas of your 
presentation, run programs, play movies, play sounds, and other 
“action items” as you click or move your mouse over the item.  A 
ScreenTip will display informing you of the type of action that 

PowerPoint performs with the selected button. In the Action 
Settings dialogue box you can assign movement/ navigation, to 
run a program, to play a sound or movie, or a host of other 
activities, including hyper linking to a web site provided you are 
connected to the Internet!  Notice the action can occur at a Mouse Click or Mouse Over 
(I’m so spastic with the mouse at times, especially in giving a presentation that I keep mine on 
Mouse Click).    The Hyperlink to: will allow you to go to files in your slide show, computer, 
or the Internet.  

 

I have so many applications that I use these buttons for – I could write a book.  I use this to play 
videos, recordings, etc during my presentation.  I use these to open other documents and to 
display web pages on the Internet.  You can change the icon or draw a new AutoShape, picture, 
or other item and assign Actions to it using the Action command button on the Insert Tab and 
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the Links Group. Note:  The Action Buttons only work when you are in Slide Show View and 
during your Presentation.  

Let’s create several type of Action Buttons. 

On your Photo Gallery Slide, we’ll create a button and we’ll use some of these pictures to 
perform actions. 

1. Navigate to your Photo Gallery Slide. 

2. Click the Insert Tab and click the Shapes 

button, 

3. From the Cascading Menu, click the Home 

Action Button. 

4. You are back in your slide, Click and drag an area on your slide to 

create the button.  

5. After you draw the Button, the Mouse Click Tab appears for you to 

create your Action Settings. 

6. I have made my Home Action button to hyperlink to 

the First Slide in the Presentation. 

7. Click OK. 

8. Your Action Button will not work until you place your 

presentation in Slide View. 

9. Put this slide in Slide Show view. 

10. Notice your slide runs as usual and displays the 

home icon for you. 

11. As your slide is running, click the Home Action 

Button and your slide stops and displays your first 

slide. 

12. Press the ESC key to end your show. 

 

Let’s create an action setting for one of our pictures. 

1. Navigate to your Photo Gallery slide. 

2. Click on a photograph to select it and on the Insert Tab click 

the Action button in the Links group and is displayed at 

right.  Notice the handy Hyperlink button next to this that 

you may use, too. 

3. Your Action Settings Dialogue Box appears.  As pictured 



Greg Creech  Page 80 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

below I have changed my Action Settings in the Hyperlink to a URL.  

Once I select URL item, The 

Hyperlink to URL dialogue box 

appears. 

4. Type in a Website that you would 

like to hyperlink to (Remember to 

connect to the Internet to use this 

in the Slide Show.  I have witnessed 

a presenter try to use this setting in 

a presentation but forgot that they 

were not connected to the Internet, 

OOPS!) 

5. Click OK in the Hyperlink to URL 

box. 

6. Click OK at the Action Settings 

Dialogue box. 

7. Put your slide in Slide Show view 

and as the Slide runs or after the animation is complete, click the 

picture containing your action setting or URL.  If you are connected the 

Internet, clicking the picture will take you to the website. 

8. After viewing the website, you can click the close button, and you 

return to your slide show. 

9. Press ESC to exit Slide Show View. Save your work. 

Let’s create an Action from our Chart to an Excel Spreadsheet. As I related when we created 
the chart slide using PowerPoint – I like creating my charts in Excel where my data is usually 
stored.  I copy my chart from Excel into PowerPoint and when I need to go to the Excel file to 
view the actual data I click the chart in PowerPoint and my Excel file opens with the data.  

1. Navigate to your Chart Slide. 

2. In Normal view, Click on the Chart to select it. 

3. Click the  Action button on the Insert Tab. 

4. In the Action Settings Dialogue Box and 

Mouse Click Tab go to the Hyperlink to 

section and in the drop down arrow pick list 

choose Other File … 

5. Next Browse using the Hyperlink to Other 

File dialogue box to where your course files 
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for this training package are located and Click the Excel file named - 

PowerPoint and Excel. 

6. After clicking the file you return to your Action Settings Dialogue Box.  

My directory and path to the PowerPoint and Excel.xls displays at right. 

7. Click OK. 

8. Place your Chart Slide in Slide Show View. 

9. After your Chart displays after the animation (if you have any), Place 

your cursor over it and the Pointing Hand icon will appear with a 

screen tip of where your file is located. 

10. Click the Chart. 

11. The Excel File will open for you to see the information. 

 Write your notes here:_______________________________________ 

 

_____________________________________________________________ 
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Using PowerPoint with other applications, such as Excel, is popular, but can be confusing and 
yield results you do not want.  My preference is to use the Action Settings to hyperlink and 
open a file in the appropriate application.  However, others prefer to link or embed the objects 
within PowerPoint for display.  We will look at the ways of inserting files as a linkage and 
embedding the file within PowerPoint. We will continue to use Excel as our example, but you 
can use many file types within PowerPoint.   

Here are some important notes on Linking and Embedding files in PowerPoint: 
 Do not move the file after linking; PowerPoint may not keep track of where you 

moved the file and you will need to redefine the linkage and file location. 

 If you email the PowerPoint file without the linked file, the linkage is broken as well. 

 You should keep your linked files in the same folder with your PowerPoint 

presentation if possible, to save confusion and ease of finding the linked or embedded 

fil. This is especially true if you are using your presentation on another computer than 

the one you used to create the linkage. 

We will use various methods of linking and embedding and using good old copy and paste, too. 

First, let’s insert the Excel file as a linked file. 

Linked Fi les  
1. Create a new Title only slide somewhere in your presentation. 

2. Give the slide a title; I’m giving 

mine the title of Linking and 

Embedding Excel. 

3. Click the Insert Tab and Click the 

Object button in the Text Group.  

The Insert Object Pane appears as 

displayed here. 

4. First, Click the Create from file 

option button to select it. Rarely will 

you create a new file from within 

PowerPoint; most of the time you 

already created your file and want to 

use an existing file within 

PowerPoint. 
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5. Click the Browse button and navigate to where your file is stored. 

Select your file and double click it to add it to your presentation or 

select your file and click OK. 

6. Next click the Link check box to establish our linkage.  I am using a 

picture of the Excel workbook to click in the presentation; you may 

want to use the Display as Icon option rather than having a picture of 

the file in the presentation.  The picture or icon is a shortcut to your file 

which will open when clicked. 

7. Click OK and PowerPoint inserts the Excel file as a picture for you. 

8. Put the slide in Slide Show and you can see your file. If you click the 

file’s picture, PowerPoint progresses to the next slide. This is fine for 

small Excel worksheets but not for large worksheets with plenty of 

data.  

 Important Gotcha! PowerPoint is limited in the space that it can display your 

file’s picture.  If you have a big Excel file to present, PowerPoint will not be able to 

show all of your data and reducing the size of the photo will probably make your file 

very difficult for the audience to see or read. This is one reason I rarely use this type 

of linkage to display a file.  If the area to display is small from the file, then this is 

not a problem.  

1. Place your Slide in Normal view and double click the photo of the Excel 

file. 

2. Excel opens for you to edit your information. 

3. Save and close the Excel File. 

 Hot Tip! If you right click on the photo in normal view, the 
short cut menu displays Worksheet Object with a submenu for 
you to edit, open, or convert your file.  This is helpful in 
opening your file to manipulate the data and change your 
information.  Then saving your Excel file automatically updates 
the PowerPoint file and photo.  This is an advantage of linking 
– your information in PowerPoint is always current and up to 
date with the Excel file. This is helpful to refresh your data in PowerPoint 
from Excel with the Update Links item. 

1. Save and close your PowerPoint 

presentation. 

2. Open the Excel file and make 

changes.  Save and close the file. 
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3. Next, Open your PowerPoint presentation.  The dialogue box here 

displays alerting you to changes to your updated file.  You usually 

know the source of the file and want to click Update Links. 

4. Click the Update Links and your presentation has the changes from 

Excel. 

5. Navigate to your Linked and Embedding slide.  PowerPoint has updated 

the information for you. 

6. Save the presentation. 

Insert ing as  an Object  
 

Now, we will insert the Excel file as an Object. While you may edit the object in 
PowerPoint/Excel, there is no linkage so the Excel file and PowerPoint object are no longer 
connected and will not update the other file.  If you place the file as an object, the object 
remains with PowerPoint if you were to email the presentation as an attachment or use the 
presentation on another computer.  A linked file does not “travel” with the presentation, and 
an object does. 

1. Create a new Title Only slide and give the slide a title. 

2. Click the Insert Tab and in the 

Text group click the Object 

button. 

3. Select the Create from File option 

button and then click Browse to 

navigate to your file. 

4. Select your file and Click OK (or 

double click the file) to insert the 

object into PowerPoint. This is a 

snapshot of your file.  The file 

and PowerPoint will not update automatically; however, you may edit 

the information within PowerPoint. 

5. Click OK. 

6. As with Linking, PowerPoint places a photo (or an icon if you chose 

that option) of the file on your slide. 

7. In Normal view, Double click the photo and PowerPoint opens with 

Excel for you to edit the file.  When you click away from the photo/file, 

PowerPoint automatically updates the information and exits Excel. 

8. Save your presentation and view the slide in Slide Show. 
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You may edit your object separately from the original file and 

PowerPoint contains the file, not the original location. 

Copy and Paste  an Excel  Chart  
With all of the above linkages and objects being embedded the ability to animate can be 
limited.  You may only bring in the object (or use emphasis and exit but those are rarely used in 
a business setting for objects).  When you copy a chart from Excel you may paste is as an object 
linked to Excel.  This allows you to animate the chart entirely making the chart easier to read 
and presenting the chart more interesting to you and the audience.  

1. Create a new title only slide and give it the title: Budget analysis 

2. Next, Open the Excel file entitled PowerPoint and Excel. 

3. Click the January Pie worksheet. 

4. Right click in the Chart Area from the short cut menu click Copy. 

5. Save and Close Excel. 

6. Return to your Budget analysis slide and right click 

in an empty area of the slide and click Paste. Click 

the Paste Options icon choose Chart (linked to 

Excel data).  This option allows you to make 

changes to the Excel file and have the chart 

automatically update. 

7. You may click the Edit Data button on the Design Tab of the Chart 

Tools with the Chart in Normal view and Excel will open the file for you 

to edit.   

8. Now, Animate your chart as we accomplished previously.  

I used PowerPoint 2010 for this section; however, the process and menus in 

the current versions of PowerPoint are similar and function the same. 

The other options in the Paste Options menu are important to know: 
 Include the Excel Chart (entire workbook) which inserts the chart and the January 

worksheets as a workbook – however, this creates an object in PowerPoint separate 
from your original file.  You may edit the data but this does not affect the original Excel 
file. 

 The Paste as Picture inserts the chart as a photo object and does not allow extensive 
animation and no Excel/data editing.  However, you can edit the chart using the Picture 
tools and have a fancy photo of the chart but with limited capabilities. You may use the 
picture as a hyperlink to open the file when the slide is in Slide Show.   
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Since we have learned many of the features and elements of PowerPoint and the associated 
tabs, command buttons, etc., we are ready to develop our own templates and presentation 
designs.  As I wrote, avoid the PowerPoint Templates, except to learn, to get ideas, or to edit 
and change them.  Developing your own template can be fun, is creative, and impresses your 
managers and audience beyond “presentation” belief.  The branding and marketing of your 
organization and products/services increase dramatically when you create your own design 
template incorporating your logos, color schemes, and slogans. Let PowerPoint help you with 
your marketing, branding, and creativity with your own template. 

 

The  in PowerPoint allow you to make global changes to all Slide, Handout, and Notes Masters
of your slides at one place.  For example, if you use the  you can change the color Slide Master
of your title or change a bullet in Slide Master and when you close out of slide master the color 
change and new bullet will appear on all of your slides. 

 

You should use templates and themes for formatting, colors, backgrounds, and other items 
needed for the slide show.  Templates and themes are NOT the slide show.  Templates and 
themes provide the style of fonts, the type of bullets, the colors for items, graphics that are to 
appear on every slide, and so on.  Templates should NOT contain your words or titles, except 
for perhaps company name, slogans, or other brief text that you want to appear on each slide. 

 

 Hot Tip! The difference between a Template and a Theme. An application 
uses a template to create a blank, “skeleton” of the document for you to 
complete. A Theme spans the Office Suite and includes colors, fonts, and 
other attributes that the entire Office applications uses.  

 

We will use  to create a Template and then save it as a Theme that will contain Slide Master
only two or so slides and then we will use our template on our existing PowerPoint file.  Ready?  

 Let’s be creative 

1. Create a New Blank 

presentation (I use the 

good, old keyboard shortcut 

of CTRL + N), click the View 

tab and the Slide Master 

button  
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2. PowerPoint opens a new tab in the front of  The Ribbon    

 

Although, this appears that we are in our presentation – we are in an editor that will globally 
affect all of our slides.  You may use  in any presentation to affect all of your slides, Slide Master
such as changing bullets, adding a graph, including a logo, etc.  Any new slides you add will take 
on the appearance that you change in .  This is very important to change all of your Slide Master
slides at one step and one stop – The All Powerful .  This is how I take an existingSlide Master  

 template and customize it to fit my personality and presentation style.  The PowerPoint Design
design I use is based upon the  template Flow.  I have developed my own PowerPoint Design
templates as well and customize them to fit the audience to whom I am speaking.  As a 
musician I have created a musical design template that I use when playing the piano or 
entertaining using PowerPoint. 

 Hot Tip! PowerPoint 2007, 2010, and 2013 are similar in the Slide, 
Handout, and Note Master views. All versions function the same and contain 
similar command buttons and group on the Master tabs. I’m using Office 
2010 and 2013 below.  

 

Master  View Tabs 
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 should activate when you click the .  The Master Tabs Slide, Notes, or Handout Master button
The  are pictured here.  The  will display the Handout and Notes Master Tabs Handout Master
number of slides per page of your 
handout.  I used the Handout and 

 to create the the Notes Master
PowerPoint handout that 

accompanies this manual.  As we will learn with Slide Master, you make changes to your slide in 
this Master view and the changes will affect all of your slides.  For example, in my Notes and 
Handout master I changed the location and the formatting, such as font, color, etc, of the 
Headers and Footers, but no Background color, since I usually print these using a color printer.  
Since the tabs are very similar and you have used many of these features previously in 
PowerPoint, we will concentrate on the Slide Master.  You should use the Notes and Handouts 
Master for your logos and other elements for your printed views. 

The  pictured above contains command buttons that we will use in the Slide Master Tab
upcoming exercises as we build our custom design template and theme.  

Here’s a brief description of the Groups and important command buttons. 

Edit Master Group -  Insert New Slide Master and Layouts for you – Allows you to 
create another slide master in the same presentation – I usually use only one master for my 
slide show. I’ll leave this to you to create multiple Masters for one presentation. 
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Insert Layout – Adds a new default layout slide for you to edit and create a new layout. 

 Delete Master – Allows you to delete the selected Master. 

Rename Master – Allows to rename the selected Master. 

 Preserve Master  Allows you to keep your changes for this master to reuse.  As you make  –
changes you can preserve the master so you can have multiple masters within the same 
presentation. 

Master Layout Group  Allows you to select or deselect components of your slide such as  –
Title, Date, Text, etc.  I usually leave this alone and work with the placeholders that I have on 
the Slide Master. You can add content using the Insert Placeholder and deselete Title and 
Footers to remove them from the Master. 

Edit Theme – This is similar to our Slide Design Tab and the Themes we used before.  

Background – Allows to create your own background including pictures and other fill 
options. 

Page Setup – Allows you to customize the presentation for specific dimensions and 
projection types for slides, notes, and handouts. 

Slide Orientation – Allow you to change your Portrait and Landscape settings.  

Close Master View   Closes you out of Slide Master and returns you to your presentation.  -

A Custom Theme and Template  
Now, that we have an overview of the Master Tabs and we have covered formatting, pictures, 
and so many other elements of PowerPoint, we are able to create our personalized design 
template and Office Theme.  We will review many items that we have learned in this course.  If 
an item is not covered in detail here for you, please refer to the previous sections of this book 
to receive the details about the items, such as using the formatting options and Mini Toolbar.  I 
encourage you to take time and to add your own logos and items using this as a guide. 

 Hot Tip! The Top Slide in the Master view is the Theme Slide. Any item or 
format you change on this slide affects ALL slides. Individual layouts affect 
only those slides that use the layout. We will use the Theme slide and 
Individual slides to customize our presentation template and theme.  

Put on your creative hat and let’s create. 

First:  A Background. 
1. With your blank presentation in Slide Master View,  

Click Background Styles and choose a style. 

2. Next click the Background Styles button again and click 

the Format Background. . .  
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3. The Format Background dialogue box appears; we have used this 

dialogue box in previous parts of PowerPoint, such as fills for Shapes. 

4. The Background fill is powerful and working with 

the Stops and colors is tricky.  

5. I am using Gradient fill and then adding and 

changing my Gradient Stops and Colors.  You may 

use photos, textures, and solid fills from this. 

6. Take a few minutes and play around with this to 

discover all of the neat effects you can have using 

the Type and Stops for the Gradients and the look 

at using a picture or texture fill.   

7. If you use a picture, you may need to lighten the 

picture or change the colors. 

You can view the Preset color schemes – some are really good and 
some are shockingly awful – you decide!  I like the Gold preset.  

 Also, note the tabs of Texture, Pattern, and Picture.  Preview them and experiment with 
them as Backgrounds.  Some Texture, Patterns, and Pictures may make it difficult to find a 
font and other colors for your presentation to be effective and legible.  For pictures, you 
should use a photo editor or Picture Format tab and tools to fade or washout your picture 
prior to adding it as a background here.  
At this point, my clients and students leave me in the dust of creative design.   I 
admit I have borrowed from my clients’ schemes they create in this view.  The 
PowerPoint 2013 Format Background Task Pane appears here. PowerPoint 2013 uses 
more Task Panes that Dialogue boxes for items like formatting.  

Once you have your Background color scheme chosen  Click OK or 

Apply to All. 
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Second:  A Color Scheme 
Now, your background is presented in Slide Master.  Next, we need to select our 
Text, Fill, and other Colors. 

1. From The Slide Master tab, click the Colors button and from 

the menu choose a new color scheme (I am using the scheme 

we created earlier in our course). Or you may design your own 

color scheme using the Create New Theme colors. 

2. Click the Create New Theme Colors… item at the bottom of the 

menu. 

The Create New Theme Colors menu opens.  

Select each item, such as Text/Background, and Click drop down 

and select different colors for each of your items.  You’ll probably 

make some bad color choices in the beginning, while your color 

choices may look good here, they may look terrible on your slide 

show.  As I wrote, time to play and experiment. 

 Note that you can name your new color scheme for using in the design and other 
presentations.   

Once complete with your color scheme, Name your 

new color them and click Save. 

 

After creating your custom Theme Color you may 

edit, delete, and apply the color by right clicking your 

color them from your Colors button and menu. My 

Geek Lite shortcut 

appears here.  
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Third:  Font Formatting 
As I wrote in my Design tips, Sans serif fonts (those without little strokes) make 
better titles and headings and try not to use more than three different fonts in your 
presentation.  

1. Select your Theme Slide, which is the top slide on your Layout 

Pane 

2. Click in the Text Box that reads Click to Edit Master Title 

Style. 

3. You may use the Slide Master’s Fonts button and menu for 

your Font themes and create a scheme as I have 

accomplished. 

4. The Create New Theme Fonts box appears at right and I 

named it Greg’s design. 

5. Next, Change the style of your fonts using the 

techniques we have used throughout this 

course. First click in the area or line you wish to 

change your font and use several methods to 

format your text, such as: 

 The Mini Toolbar, 

 The Home Tab and the Font and Drawing 

Group’s command buttons, 

 The Format Tab under Drawing tools, 

which I used to change my title font and 

give it a different color fill and then I 

gave it Text Effects.  This is displayed at 

right. 

6. Format your text and fonts as you wish. 

 Fourth:  Bullets 
Bullet Styles and Formatting 

Another appealing and creative endeavor is modifying 
your bullets or numbering in Slide Master.  You may 
change bullets for a single slide or item or using Slide Master all of your 
bullets change for your slides.  To change and customize your bullets follow 
these steps: 
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1. On the Theme Slide (the top slide), Click the First Bullet on your Slide 

Master. This will affect all of our bullets. 

2. On the Home Tab Click the Bullets Drop Down arrow button, a 

cascading menu will appear as shown at right; you may use bullets 

listed here by clicking the bullet’s box.  

3. Click Bullets and Numbering at the bottom of 

the menu. 

4. The Bullets and Numbering Dialogue box 

opens with two tabs for you to customize 

your bullets or your numbers. 

Your screen may look different.  The dialogue box contains your 
most used bullets and several popular ones. 

You may click the Picture button to activate Clip Art and other 
bullet pictures or Click Customize to activate the Symbol 
dialogue box. Let’s change our first bullet using Customize for 
a font/symbol bullet and then we’ll use the Picture bullet for 
our second bullet level. 

Symbol/Font Bullets 
1. Click the Customize button at the Bulleted Tab of Bullets and 

Numbering. 

2. The Dialogue Box at right appears. 

3. Using the Drop Down Box for Bullets 

From:  Select a font – I’m using 

Wingdings – a popular symbol and 

bullet listing; Webdings offers 

additional interesting bullets and 

symbols. 

4. Click a bullet symbol of your choice.  

5. Click OK. 

6. At the Bullets and Numbering 

Dialogue Box, change the color to fit 

your color scheme and change the size to 95%. 

7. Once complete, Click OK.  Your bullet appears.  

Bullets Position 
You may change the position of your Bullets and Text by using the Ruler on individual slides OR 
on all of the Slides in Slide Master.  Notice the Ruler at the top of your screen when you select a 
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bulleted item, the small “arrow” and box moves your bullet and text (the top, down pointing 
arrow moves your bullet AND Text as you Click and Drag the arrow, the Upward pointing 
arrow moves your Text as you Click and Drag the arrow, and the box moves both the bullet 
and text at the same time as you click and drag the small box.  Sometimes the bullets can be 
too big for the text and vice versa so you may need to use the ruler and arrows to create more 
space between your bullet and the text).  

Picture Bullets 
1. Click on your second level or sub bullet on the Slide Master. 

2. Click the Bullets Drop Down arrow and from the menu click the Bullets 

and Numbering button at the bottom of the pane. 

3. The Bulleted Tab of Bullets and Numbering opens for you. 

4. Click the Picture Button and The Dialogue Box at right 

appears. 

5. Scroll through and choose a bullet – notice you can search 

for specific bullets and use Office Online for more bullets. 

6. You may use your own logo or picture as a bullet clicking 

on the Import. . . button. 

7. Click OK.  

8. Your new picture bullet appears.  

9. Save your Presentation as My Design Presentation.pptx. 

Fifth:   An AutoShape, Logo, or Picture 
Your presentation should include your logo or applicable picture on every slide.  Using the 
previous instructions insert a picture, clipart, or draw a shape to fit at the bottom right of 
your slide show.  Another suggestion is to use your Line tool on the Drawing toolbar and draw 
lines to separate your title and text areas and perhaps a vertical line at the right or left area 
of you slide.  Be careful not to make the picture/logo so big that it will interfere with your 
text and title or other components of your slide show.  

We will use a logo on our slides, but we want the logo placed differently on our Title Slide than 
the other slides. We will add a line to separate our Title and our Content. 

Slide Layout and a Logo 
1. On your Title Slide Layout, 

usually the second slide in your 

Layout Pane beneath the Theme 

Slide. 

2. Using you Insert Tab and 
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Picture, add a logo or picture to your title slide, as displayed at right. I 

am place my logo prominently in the center of the slide. 

3. Using your Line Tool in the Shapes button’s menu, click and drag a line 

between your Main Title Text Box and Your Subtitle Text Box on your 

Title Slide 

4. Format your Line using your Drawing Tools. My Title Slide Master 

appears at right. 

 

1. Next, Click your Title and Content Layout Master. 

2. Copy your logo/picture from the Title Slide and Paste it onto the Title 

and Content Slide.  

3. Resize the logo and move the logo to the top 

corner of your slide. 

4. Next, Copy the Line from your Title slide and 

paste it onto your Title and Content slide. 

5. Move the line between your Title Text 

Header and the Content Pane on your slides. 

6. My Title and Content Layout Master appears 

here.  

 Hot Tip! When you select object(s) on one slide 
and copy it, PowerPoint remembers the exact 
positioning so when you paste it on another slide, the placement is terrific 
for you. We will do this on the remaining Slide Layout Masters. 

1. Press your shift key and click your logo and click your line. Keeping the 

shift key pressed 

allows you to select 

multiple objects. 

2. Copy these selected 

items from your 

Content and Title 

Slide Layout and 

paste it onto the 

Two Content.  

 Notice that when you hover over a Slide Layout PowerPoint tells you the Name of the Slide 
and how many slides use that Layout’s Master. I have circled this above. PowerPoint will  not 
let you delete a master that has slides using it. 
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1. Now, continue pasting your items to the other Slide Layout Masters. 

You may not want these items on your Blank Layout Master and may 

need to move your items around so they don’t block some of your other 

content placeholders. 

Sixth:   Animation for a Title 
NOTE:  While you may add animation to your logo or other objects in Slide Master, I 
encourage you not to use animation in Slide Master for all of your objects or at least keep your 
animation to minimum in Slide Master.  I usually animate my title in Slide Master to ensure 
consistency and that all of my titles come in automatically (With Previous) as I build and use my 
presentations. Remember everything you accomplish in Slide Master can affect ALL of your 
slides.  We’ll add animation to our Title. 

1. Click on your Theme Slide, the top slide, and select your Title Text Box.  

2. Using your Animation Tab, add an Entrance Effect animation that 

comes in With Previous. I am using Zoom.  

 Hot Tip! You will want to remove any animation we added earlier to each 
slide. Having the Animation on our Theme Slides automates all of our titles. 
Having the two animations may produce unwanted results. You should set 
your animations in Slide Master Layouts using Slide Master or individually 
add animation to each slide using our Normal vies, which we have done.  

Seventh:   A Custom Layout 
While PowerPoint has plenty of Layouts, you may want your own Layout Master to use in your 
presentation. Let’s create our own Layout. 

1. Click on your Title and Content Layout Slide, 

2. Click the Insert Layout Button, PowerPoint Inserts a blank 

layout below your current slide layout. 

3. Copy and paste your logo and line onto your new, blank layout. 

4. Using the Insert Placeholder button and the cascading menu, I 

am choosing Chart. 

5. After I click my placeholder (chart in this case I click and drag 

an area in my slide for the chart.  

6. Next, I add a 

picture. 

7. Finally, I add a 

Text box. 
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8. My custom layout appears here.  

 

 

 

9. Finally, I right click on my New Custom 

Layout and from the Shortcut menu I 

choose Rename Layout. 

10. I am renaming the Layout to Chart, Picture, 

and Text. 

11. Using the Shortcut menu at the far right, I delete layouts 

that I do not use.  
 

Finally:  Headers and Footers 
You may add and edit Headers and Footers at any time using Headers and Footers from the 
Insert Tab.   However, only in Slide Master can you format and rearrange your headers and 
footers.   While we are working on our template and Slide Master, let’s edit our Headers and 
Footers formatting and placement. 

1. In Slide Master, you will notice the bottom of your slide from left to 

right contains the Date, Footer, and Page number areas.  You can click 

and drag these to other areas of your slide.  You can select these boxes 

and format them, too.  I changed my Footer Area Font color and 

formatting my Date and Numbers differently. 

2. Select your footer area box and format it with a different font, color, 

and perhaps make it bold. 

3. If you like you can change your Date and Number areas, too. 

4. The changes that you made in the Slide Master – the First and 

Important Slide. 

Our Design is ready! 

  Note:  We only choose formatting options – we did not and should not enter text in Slide 
Master – just formatting, objects, backgrounds, etc. 

1. Click the Close Master View icon on the Slide Master Toolbar to Close 

Slide Master!  
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2. Save your beautiful work.  Your design and template Saves as a 

presentation, not a template or Theme, yet. 

In using the Master you can click the Preserve Master icon.  This allows you to create multiple 
masters to use within the same presentation.  This is similar to having your presentation 
contain different design templates; in fact your Design Tab will contain your Masters in the 
Design choices for this presentation.  When you preserve a Master, you are in essence “saving” 
the master although you are not saving the master as a file.  These masters are only available in 
this presentation.  We will need to save our presentation file as a template and then a Theme 
to use in other PowerPoint presentations and files. 

Now you should have your presentation in Normal view!  Time to save our file as a 
Presentation Design Template.  

 

1. Using the Microsoft Office Button’s Menu in 2007 or the File Tab in 

2010 and 2013, trace to Save as and click the Other Formats button or 

press the F12 key on your keyboard for the Save As dialogue box. 

2. The Save as Dialogue box is open.  

3. In the Save as Type box, using the 

drop down list, select PowerPoint 

Template.potx. 

4. The Look in box will change; 

PowerPoint takes you to where all of 

the Templates that Office uses are 

stored. Know where this file and 

directory is located; you will need to 

know where this is in your Design Tab.  

You can save this file wherever you 

like. 

5. Name your Template an appropriate 

title. 

6. Click Save. 

7. Close all of your files and exit PowerPoint. 

With your Template saved Close out of PowerPoint Completely. Now, let’s use your Template. 

1. Using the Microsoft Office Button’s Menu in 2007 or the File Tab in 

2010 and 2013, trace to New and click it. 
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2. At the next dialogue box in PowerPoint 2010 you may click the My 

Templates button or New From Existing to use 

your template. 

3. My Templates appear here. Select your 

template and click OK. 

4. PowerPoint creates a New Presentation based 

on your Template. 

You may use the New From Existing to create a 

new presentation based on an existing template. 

This allows you to browse to locate your 

template.  

 

You will have to know where your template stores in order to open it and 

edit it for future presentations when needed. 

 

PowerPoint 2013 has Featured and Custom selections my Custom selections 

appear below.  

 
 
 
 
 
 
 
 
 
 
 

PowerPoint saves 
templates with POTX extension, for example my file name is PracticeTemplate.potx.  We’ll 
look at the other formats later, such as Show 
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1. Open your presentation that we have modified our colors and fonts or 

create a New Presentation based on your Template that we 

accomplished. 

2. Activate the Design Tab.  

3. Click the More Arrow on your Themes Group to 

display all of your Themes at the bottom of the 

Gallery click Save Current Theme. 

4. Like our Template, PowerPoint navigates to where 

all of the Office Application uses the Themes.  

5. Save your Theme with an appropriate name. 

6. Now, in your Design Tab your Theme appears in your 

Themes gallery. 

7. Now, open Word or Excel and in the Page Layout 

(Word 2013 uses the new Design Tab for your Theme 

selection) Tab, click the Themes button and from the 

menu you should see your new theme. 

Themes affect your colors and fonts for your objects, such as Headings, 

Charts, Photo effects, and Tables. 

 

Now to Practice  
Here are exercises you should try on your own using your Template and 

Design. 

1. Create a new presentation based on your template. 

2. Using the Reuse Slides pane insert slides from other files 

3. Notice that while the contents of the slides change the formatting does 

as well unless you check the Keep Source Formatting Box. You may 

have conflicts in colors, animation, links, and so on.  

4. Look at other Themes for your presentation using the Design Tab. 

 

 

.
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PowerPoint  Show  
One of the Presentation types that you can save your presentation as is a PowerPoint Show – 
this saves your file with a .ppsx or .ppsm extension; the m in the .pssm extension is for macro 
enable PowerPoint Shows which we have not accomplished so I am saving mine as .ppsx file.  A 
PowerPoint Show file will only open and display in Slide Show View.  If you press Esc to end the 
show you return to where you opened the file. 

I use this when I e-mail presentations to my clients and do not want them to change my show 
or I want to create an easy way for them to view the presentation – simply by double clicking 
the PowerPoint file’s icon in the e-mail.  

1. To save a presentation as a show, 

2. Activate your Save As Pane (I simply press my F12 key which works in 

all versions of Word, Excel, and PowerPoint). 

3. And from the Menu choose PowerPoint Show.  In the Save as dialogue 

box, change the Save as type to PowerPoint Show (.ppsx). 

4. Then click Save. 

5. Your presentation is now a Show, too. Your icon for the a PowerPoint 

show is different than a presentation and the 

2007 version of a .pssx icon displays here.   

 Write your notes here: 

________________________________________________________________________ 

 

________________________________________________________________________ 

An Invitat ion or Greeting Card  
Our next PowerPoint Presentation will be an invitation or greeting card. 

Using PowerPoint as an electronic invitation or greeting is innovative and fun.  Be careful about 
the size of the file you are creating for those people who have slow Internet connections or 
older computers.   

 

If someone you e-mail your PowerPoint presentation to does not have PowerPoint, they may 
download PowerPoint viewer for FREE from Microsoft Office’s web site.  PowerPoint Viewer 
allows anyone to view PowerPoint presentations; however, no edits, changes, additions etc. are 
allowed. 
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Create a one page presentation to use for a birthday card, holiday card, thank you card, etc. 
using the following items, we have learned. 

 Use the Drawing tabs and menus to create objects, 
 Include a photo, Clip Art, and/or sounds,  
 Include animation on your text, title, and objects, 
 Include a header and footer, 
 Design a background for your invitation, 
 Use WordArt as a title for your card/event, 
 Let your imagination and creativity flow. 
 Save your file as a presentation and as a show. 

 

Kiosks  or  Stand Alone Presentations  

Have you ever seen a computer display a presentation automatically?  You can see these at 
trade shows, in lobbies of businesses (particularly hotels), and at booths in malls.  This is known 

as a kiosk type of presentation.  This is particularly useful at conventions or conferences after I 
make a presentation I will be at a booth with the presentation in kiosk mode so participants can 
review the information or new clients can view the information without my intervention. After I 
make my presentation, I like for the PowerPoint show to continuously loop at my booth or 
table.  Here are the steps to change your presentation to run continuously and 
automatically. 

1. Click the Slide Show Tab and then Click Set – up Slide Show in the 

Set Up Group, 

2. Click the Browsed at a kiosk (full screen) item. 

3. The Look continuously grays out because 

PowerPoint will automatically loop or 

repeat your show. 

4. I have no Narrations and I want my 

animation to display.  

5. I want to view all slides. 

6. Finally, I want the show to run 

automatically by having the Radio Button 

for Using timing, if present selected. 

7. Then Click OK. 

 

 An Important Gotcha!  You should go through your slides to animate them and use 

automatic transitions based upon time periods of a few seconds or a minute or so!  Your 
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automatic presentation won’t be automatic without setting your automatic timings in Slide 

Transitions and Animations.  Learn from my bad mistakes!   However, you can allow the 

user to scroll through your presentation manually, but they may be smart enough to 

change or alter your slide show.  I prefer automatic and then remove my keyboard from 

the computer or get a protective cover for the keyboard and lock it, so my presentation are 

not altered.  

1. Click on your Transitions Tab (PowerPoint 2010/2013 or the 

Animations Tab in PowerPoint 2007).  

2. Choose a Transition Effect. 

3. In the Timing Group, Change your 

Advance Slide from On Mouse Click to 

After and give your slides a number of 

seconds to display. I have mine at five 

seconds. 

4. Press the Apply to All button! An Important and easy to forget step. 

5. Save your presentation. 

6. Press your F5 key to start your presentation from the beginning or click 

your Slide Show button. PowerPoint should run through your 

presentation and loop because of the settings in the Slide Show 

Options pane and setting your automatic transitions. 

 

Narrat ion/ Rehearsed Presentation  
Overview 

You can use PowerPoint for narrated presentations, tool.  If you are going to present your Slide 
Show without a lot of audience interaction and you do not vary from your script, you may want 
to set your show to run automatically.  Here are the steps to guide you; however, 
patience and thorough understanding your material is in order before attempting 
this.  Be prepared to spend some time and patience with this to get it perfect – 
Remember Timing is Everything – you don’t want to be stumbling on stage while 
PowerPoint runs through the Show.  You will definitely have to practice, practice, 
practice to get this perfected.  I have used this for recognition and award events 
for regional and national conventions.  The narration can be from a sound file or 
CD.  As the narrator describes the person or achievement PowerPoint displays 
information about the person or achievement keeping with the narrator’s points 
and voice over.  First, I insert the sound file (usually a .wav file from a 
professional voice over artist and then I use a combination of Custom Animation 
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within the Slide’s photos and objects (as we have learned) then I use Rehearsal to move from  
slide to slide. 

Here’s how to create a Narrated/Rehearsed Presentation. 

1. Put your Presentation file in Slide Sorter View. 

2. Click the Rehearse Timings Icon in the Slide Show Tab as pictured here 

3. The Slide Show opens with a Rehearsal toolbar described below. 

4. You practice your presentation and advance through the items and the 

slides.  The arrow is your advance button. 

5. If you are interrupted or need to stop, you 

can press the Pause button to suspend the 

timing.  When you are ready to begin again, 

Press the Pause button, again. 

6. The First timing Box displays the Elapsed time of the current slide 

7. The Looping Arrow restarts the current slide for you to re-do the slide 

and narration. 

8. The Final timing Box displays the Total time of the Slide Show 

Presentation. 

9. Once complete, Click the Close Icon on the Rehearse Timings Toolbar.  

PowerPoint will prompt you to save the time settings.  Click yes to save 

or no to start over.   

10. Your timings appear in the slide sorter window for each slide in the 

bottom left corner.   

An Important Note: You can manually correct items using the Custom 

Animation Dialogue box for timing of items in a slide or the Slide Transition 

Dialogue box for an entire slide(s).  Depending upon your computer and 

perhaps another computer that will run the display the timing will be off 

because of memory and chip speeds on the computer. So knowing how to 

edit timings after you have accomplished the Rehearsal is critical. 

 Write your notes here: 
________________________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 
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Presenter  View –  1  Show and 2  Monitors  
PowerPoint offers an excellent feature for speakers and presenters that want to view their 
notes, navigation buttons, thumbnails of the entire presentation, and other items and the 
audience views the Slide Show. 

These directions are generic in nature and you should check your 
hardware components and test this using your equipment and 
software.  

To set up a show that is  displayed on two monitors with a 
different view on each monitor, you must have your computer 
attached to two monitors so PowerPoint and your Operating 
System can detect the two monitors. 

1. Click the Slide Show Tab and Click the Use 

Presenter View check box. 

2. You may also the Set Up Slide Show Dialogue box. 

3. Click the Show Presenter View check box. 

4. PowerPoint may ask you to verify your set up and offer the screens at 

right.  
5. You will need 

to have the 

monitors 

attached to 

your computer and review the help files to accomplish 

the technical aspects of using Presenter View. 

6. The Show Presentation On areas becomes active in 

the Monitors group for you to select the Audience 

monitor versus your monitor. 

7. Use the PowerPoint help system and text Presenter 

view to see your options and assistance in using the 

presentation on two monitors. 

8. Also, you may need to use the Display Settings in 

Windows – my Display Settings from Windows Vista is 

displayed at right; however, I do not have two 

monitors attached to the computer. 

  



Greg Creech  Page 106 P o w e r P o i n t  P i z z a z z !
Techedutainment Services, Inc. 

Greg Creech © 2015 T e c h e d u t a i n m e n t  S e r v i c e s  Thank you for Learning! 

No Duplication  Allowed  404-299-1706 

 

Handouts/Notes  
While PowerPoint is primarily designed for on screen viewing, the Handout and 
Notes options are terrific.  We have viewed our notes using Notes View and we 
have seen that we can use a Notes and Handouts Master. You should print your 
presentation in a handout and notes format, too.  

Using your Print Preview Pane, you may select your handouts and notes printing 
layouts.  

 

 

 

 

Photo Album 
Want to show your latest traveling adventure at a party?  Or create a slide show for the 
grandparents of the kids that you can e-mail as an attachment?  Or have photos of your latest 
products that you want to show in a continuously loop? PowerPoint offers a quick and effective 
way of creating a photo album.  

  Here’s how to create a custom PowerPoint Slide Show of your favorite 
photos. 

1. In a blank presentation, click the Insert Tab and 

Choose New Photo Album from the menu. 

2. The Photo Album dialogue box appears as displayed 

at right. 

3. I have Inserted pictures from a File/Disk 

by browsing to a pictures folder and 

selecting all of the pictures in the folder by 

pressing the Ctrl  + A key (Select All) and 

click Insert at the Insert New Pictures 

Dialogue box. 

4. The Photo Album dialogue box allows you 

to rearrange your photos using the arrow 

keys or delete (Remove) pictures beneath 

Pictures in Album section. 

5. Similar to the picture toolbar, Notice that 

you can change the position of your picture using the Flip icons. 
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6. You may edit the brightness and contrast of your photos here and 

choose other options, like making all pictures black and white. 

7. After reviewing your pictures and making necessary adjustments, 

8. Click the Create button. 

9. PowerPoint builds your presentation as a photo show with a blank title 

page ready for you to share your photo album using PowerPoint. 

10. You can now add your own text and animation to each slide or photo. 

11. Don’t forget to save your presentation. 
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Like Word and Excel, PowerPoint’s view tab contains PowerPoint’s views, Zoom, Window, and 

Show groups and work similarly.  We’ll overview each group and look at the additional 

Color/Grayscale command button in PowerPoint. 

Let’s examine the different views in PowerPoint first. 

1. Open the Power of PowerPoint file. 

2. Click on your view tab. 

3. Click the Normal view command button, this view has three sections on 

the left part of your screen is the thumbnails/outline section, the middle 

section is for editing your slides, and the bottom section is your notes 

pages.  

 A Hot Tip! You may 

change your Normal view 

panes in the PowerPoint 

Options located in your 

Microsoft Office Button 

menu.  Clicking the 

PowerPoint Options button 

activates the Options 

menu. As displayed at right 

and in the Options menu, 

the Advanced section of 

your PowerPoint options 

contains a section entitled 
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Display.  In the Display section, you will notice “Open all documents in this 

view:” Mine is set with Normal: Thumbnails, notes, and slide.  You should set 

this according to the panes you like in your Normal View. 

Also, notice this is where you may increase your Undos from 20 to 150.  I 

need this very badly and wish we could increase the undos in PowerPoint to 

1050!  

 Using Slide Sorter View or your Thumbnails pane you may copy a slide to a 

new location, too by pressing your CTRL key and drag the slide another 

location.  Or you may press your CTRL + D Keys to duplicate the slide - this 

accomplishes Copy and Paste in one easy to use step!   
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lick Slide 3 to select it and press your CTRL and your D keys together and PowerPoint 

duplicates the slide by copy and pasting an exact replica of Slide 3 to the right – creating a new 

Slide 4 for you. 

4. Click your Notes Page view and 

notice that PowerPoint puts your 

slides in a view to see all of your 

Notes formatting.  In other views 

not all of the formatting, such as 

color, appears in your notes 

section.  The Notes Page view 

allows you full formatting of your 

notes sections and provides more 

space for you to write your notes. 

5. Click the New Reading View to 

Preview your Slide Show.  This is 

a new View for Office 2010. You may use the buttons at the 

bottom right to navigate through your show and to change views. 

The Bottom buttons in the Reading Pane View offers not only the  

ability to navigate but to Edit your slides and to  copy slides and 

other nice features as displayed at right for you. You activate this 

shortcut menu by pressing the button circled at right.     

6. Click the Slide Show View at the end of the Views and – This is 

the Showtime Folks View!  This places your slides in Slide Show for your presentation.  To 

exit this view press the ESC key to end the show. 

The Master Views allow you to make global changes to your slides that in one place you 

may affect all of your slides, such as putting a logo on all of your slides.   

The Show section of the View tab in PowerPoint allows you to see your rulers at the top and left 

side of your screen – this is helpful in changing 

bullets and tabs and in the placement of your objects.  

Choose this according to how you like to work in 

PowerPoint – I keep my ruler on and turn on the 
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Gridlines as needed. I keep the Guides on as well to help me center and place my objects in 

PowrPoint. 

Like in Excel, the Zoom command button activates a list of percentages to use in viewing 

your slides or other area of your screen.  For example, if you are in the normal view and 

clicked in the Thumbnails/Outline section, changing the percentage in the zoom box 

changes the Thumbnails/Outline not the actual slide view. 

1. The Color/Grayscale command button changes the slides to different types of color.  

Click this to view your slides in all of these colors.  I don’t find Pure Black and White 

helpful at all in using PowerPoint.  But the Grayscale is good for viewing your slides as if 

printed on a colorless printer.   View all of these selections and return to the Color mode. 

2. Save your file. 

 

The Window section of PowerPoint View Tab is the same as Word and Excel allowing you to 
rearrange and view multiple PowerPoint Presentations in various layouts, such as Side-by-
Side and viewing your presentation in multiple windows.  
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PowerPoint ’s  Pr int  Preview and Pr int  
1. Like Word and Excel, PowerPoint’s Print Preview and Print pane allows 

you to choose your copies, printer, range of printing, and other items.  
PowerPoint allows you to change your color scheme here and all-
important is the Full Page Slides or the former Print What command as 
displayed at right.  I have changed my option to 6 Slides Horizontal.  
Review this options and navigate to other slides and look at the 
different color options.  
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